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About this guide

This User Guide provides information about the Nortel Networks 
IP Softphone 2050 and the Nortel Networks Mobile Voice Client 
(MVC) 2050.

The IP Softphone 2050 is designed to work on a desktop PC. Information 
on the IP Softphone 2050 begins on page 10. 

The Mobile Voice Client (MVC) 2050 is designed to add wireless voice 
communication to the Personal Digital Assistant (PDA). Information on 
the MVC 2050 begins on page 68. 
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IP Softphone 2050 overview

The IP Softphone 2050 turns your computer into a telephone. To make a 
call, you dial with your keyboard or mouse. To answer a call, you simply 
click a button. Instead of holding a telephone receiver to hear and speak 
to callers, you wear a headset.

Designed to work with IP-based phone systems, the IP Softphone 2050 
provides Voice Over IP (VoIP) services using a telephony server and your 
company�s Local Area Network (LAN). 

The server that supports your IP Softphone 2050 determines what 
features you can receive. For example, your server might provide 
Call Conference, Call Transfer, and Call Forward.

IP Softphone 2050 features

The IP Softphone 2050 supports the following features:

� 12 programmable feature keys: 6 Programmable Line 
(DN)/Feature Keys (self-labeled) and six lines/features accessed by 
pressing the shift key

� 4 soft keys (self-labeled) that prove access to a maximum of 10 
features

� multi-field display

� directory capabilities that are stored locally on your PC or linked to 
external directories such as LDAP, Microsoft Outlook, and ACT! 
contact management software

� Personal Directory, Redial List, Callers List, and Password 
Administration, stored on the application server for systems running 
CS 1000 Release 4.0 software

� one-click direct dialing from various windows and applications

� 6 specialized fixed keys:

� DN/Feature Tray selection

� Directory
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� Inbox (Message)

� Shift

� Services

� Expand to PC 

� dedicated call processing keys: 

� Hold

� Goodbye

� Answer

� Volume

� Mute

� Navigation

� Message waiting

� end user-selectable ringer that enables the PC speakers or the 
headset to ring for incoming calls

� macro functions for programming lengthy dialing patterns

Main parts

The IP Softphone 2050 consists of four main parts: the IP Softphone 2050 
Call Control window, the Local Directory window, the i2050srv 
application, and the System Tray icon and menu.

The IP Softphone 2050 Call Control window
This window displays the line keys, feature buttons, and call display. You 
use this window to make and manage your telephone calls. You also use 
this window to access your Network Directory (if one is available), the 
Personal Directory, Redial List, and Callers List features which include 
Application Server Administration and Password Administration, and your 
Local Directory. 

The Local Directory window
This window enables you to create, manage, and use a telephone 
directory stored on your computer.
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The i2050srv application
The i2050srv application is the software on your computer that enables 
the IP Softphone 2050 to communicate with the communication server 
you are connected to. This application is launched when you start your 
computer, but remains �hidden� in the background. You'll see it if you 
open the Windows Task Manager.

The System Tray icon and menu
You can right-click the Softphone icon to make and manage calls.
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IP Softphone 2050 
Call Control window

The IP Softphone 2050 has two Call Control windows: Standard and 
Enhanced. Both windows contain common elements that provide access 
to the IP Softphone 2050 features.

Note: The Enhanced Call Control window is the default when you 
start the IP Softphone 2050 for the first time. You can modify the 
settings so that the Standard Call Control window appears on startup 
instead.

To open the IP Softphone 2050 Call Control window:

1. From your Desktop PC, click Start. 

2. Select Programs.

3. Select Nortel Networks IP Softphone 2050.

To open the IP Softphone 2050 Standard Call Control window from the 
Enhanced Call Control window:

1. Click File.

2. Click Select Skin.

3. Click Standard.

To access the Enhanced Call Control window from the Standard Call 
Control window:

1. Click Application Menu.

2. Click Select Skin.

3. Click Enhanced. 
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Standard Call Control window

The Standard Call Control window (shown on page 14) includes the 
standard features that enable you to make and manage telephone calls.

The elements of the Standard Call Control window are described in 
Table 1 on page 17.

Figure 1: Standard Call Control window
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Enhanced Call Control window

The Enhanced IP Softphone 2050 Call Control window (shown Figure 2 
on page 16) includes the enhanced features that enable you to make and 
manage telephone calls. The Enhanced Call Control window is also 
known as the Primary User Interface.

The elements of the Enhanced Call Control window are described in 
Table 1 on page 17.

To open the Enhanced Call Control window from the Standard Call 
Control window:

1. On the Standard Call Control Window click Application.

2. Click Select Skin.

3. Click Enhanced.

To change the information that appears on the window:

1. Click Trays.

2. Click one of the following:

� lines

� number

� combo
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Figure 2: Enhanced Call Control window
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Call Control window elements and functions

The following table describes the elements and functions of both the 
Standard and Enhanced Call Control windows.

Table 1: IP Softphone 2050 components and functions 
(Part 1 of 4)

Element Function

Application Access the Application menu.

Message Waiting 
light

Flashes when a message is waiting.

Primary display Provides call information (such as Caller ID) and 
instructions for using certain soft key features. 
When the telephone is idle, only the date and 
time display.

Soft keys The four soft-labeled feature keys are: Transfer 
for connecting calls to other people, Conference 
for group calls, Forward, and More... for 
accessing additional features.

To select a feature, click the appropriate soft key 
button, and then follow the instructions on the 
display.

The soft key features you have to choose from 
depend on:

� Your current task. The features available at 
any time depend on your current call activity.

� The features that are available. Much of the 
functionality of the IP Softphone 2050 is 
dependent on the communication server 
configuration.

Note: If more than four features are 
available, click the More soft key to see 
them.
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Show Lines Button to change the tray on the Call Control 
window (show or hide the Line buttons).

Copy Button to copy a network service, feature, or 
folder.

Quit Button to quit a network service or feature.

Navigation arrows Scroll through menus and lists in the display 
area.

Volume Increase or decrease the headset volume.

Mute Listen to the receiving party without transmitting. 
Click the Mute button again to return to a two-
way conversation. The Mute button mutes the 
Headset microphone. 

Answer/Handsfree Answer and make calls.

Hold Place an active call on hold. 

The feature key label for the held line displays a 
flashing icon to indicate the call is on hold. Return 
to the call by clicking the Line button of the call on 
hold.

Goodbye Terminate active calls.

Line keys The Softphone includes six programmable Line 
keys that can represent line appearances, DNs, 
or features. The communication server provides 
the labels that appear on these keys.

To use the programmed feature, line, or DN, click 
its Line key.

Dialpad Lets you dial a telephone number. Simply click 
the numbers you want to enter.

Table 1: IP Softphone 2050 components and functions 
(Part 2 of 4)

Element Function
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The following Standard toolbar elements apply to the Standard 
Call Control window ONLY.

Inbox/Messages To access your messages or return a call.

Outbox/Shift To toggle between feature key displays.

Directory To access a Network Directory; depending on 
how your system administrator has set up this 
service, this button may access a Local 
Directory, the Personal Directory, Redial List, 
Callers List features, or some other server-based 
directory service. You can use the Directory to 
place a call. Generally, the call will be placed on 
your prime line unless you select a different line.

Services To access a list of network services.

Open To open a network service, feature, or folder.

Copy To copy a network service, feature, or folder.

Quit To quit a network service or feature.

The following Network Services toolbar elements apply to the 
Enhanced Call Control window ONLY.

Tray Menu List To scroll through an opened directory menu.

Directory To access a directory such as the Personal 
Directory, with up to 100 entries, or Network 
Directory. 

Depending on how your system administrator 
has set up this service, this button may access a 
local directory, the Personal Directory, Redial 
List, Callers List features, or some other server-
based directory service.

Inbox/Messages To access your messages or return a call.

Table 1: IP Softphone 2050 components and functions 
(Part 3 of 4)

Element Function
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Hot keys

Within the Call Control window, the computer keyboard provides hot keys 
to access common features:

� Enter � Answer a call.

� F12 � Release or terminate a call.

� Esc � Release or terminate a call.

Outbox/Shift To toggle between feature key displays.

Services To access a list of network services.

Open To open a network service, feature, or folder.

Next Toolbar To display the next toolbar.

The following Local Directory Quick Access toolbar elements 
apply to the Enhanced Call Control window ONLY.

Previous Toolbar To display the previous toolbar.

Quick Dials To open the list of contacts stored in the 
Quick Dials section of the Local Directory.

Redial List To open the list of up to 20 of the last calls you 
made.

Callers List To open the list of up to 100 of the calls you have 
received.

Local Directory To open the Local Directory.

Show Lines To change the tray on the Call Control Window 
(show or hide the line buttons).

Copy To copy a network service, feature, or folder.

Quit To quit a network service or feature.

Table 1: IP Softphone 2050 components and functions 
(Part 4 of 4)

Element Function
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� F5 � Put call on hold.

� F1 to F4 correspond to the soft keys 1 to 4.

� Alphabetic keys map to numbers like dialpad mapping.

� Arrow keys are equivalent to the navigation keys.

� Alt-V can be used to paste data into the interface. (For example, you 
can copy a phone number from an application and paste it into the 
IP Softphone 2050 interface using the Alt-V key combination.)

Local Directory

The IP Softphone 2050 Local Directory enables you to store a phone 
directory on your computer and link to external directories. It also enables 
you to filter directories so they are easier to use.

Note: Do not confuse the IP Softphone 2050 Local Directory with the 
Network Directory that you can access by clicking the Directory 
toolbar button.

To open the Local Directory:

1. Click Application Menu.

2. Click Local Directory.

3. Click one of the following:

� Local Directory

� View Local Directory 

Note: You can also click the Local Directory icon on the Enhanced 
Call Control window toolbar.

The Shortcut Bar on the left side of the Local Directory lets you access 
groups and directories. Groups enable you to organize your directories. 
A group is represented by a button on the Shortcut Bar. Directories 
appear as icons inside groups.

To select a group, click its button. By default, the Local Directory has two 
groups: Main and Quick Dials.
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Main Group
If you click the Main Group button, three items appear:

� Local Directory - A list of your Main Directory contacts

� Redial List - A list of the last telephone calls you made

� Callers List - A list of the calls you have received

Quick Dials Group
Click the Quick Dials button, to see the contacts stored in the Quick Dials 
group.

Personal Directory, Redial List, and 
Callers List 

Personal Directory, Redial List, and Callers List are features supported on 
CS 1000 systems running CS 1000 Release 4.0 software. The contents 
of these directories are maintained in a remote, central database called 
the Application Server. 

To open Personal Directory, Redial List, or Callers List:

1. Click the Directory button.

2. Scroll through the following list and click your selection:

� Personal Directory

� Callers List 

� Redial List 

� Password Administration 

Note: The Personal Directory, Redial List, and Callers List features 
have a one-minute time-out control period. If the application is idle for 
one minute during any of the operations, the application is closed and 
your IP Softphone 2050 goes back to the idle state.
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The Personal Directory, Redial List, and Callers List features support:

� multiple languages

� access using the Directory key

� feature launch while in Call Transfer and Conference modes (your 
IP Softphone 2050 does not have to be idle)

� Branch Office in normal mode only

� Virtual Office

� menu-driven configuration of the Station Control Password (SCPW) 
from your IP Softphone

� database backup and restoration by your system administrator

� system administrator functions, like unlocking your SCPW

� system administrator restoration of profiles for single, multiple, or all 
users

User preferences for Personal Directory, Redial List, 
and Callers List
The following is a list of options you can change:

� language

� date/time display format

� call timer

� name display format

� call log options

� log all/unanswered calls

� area code setup

� preferred name match

� new call indication
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To set user preferences:

1. Click the Services button.

2. Click Telephone Options.

3. Select one of the following:

� Language

� Date/time

4. Scroll down the list.

5. Click your selection.

6. Click Select or Cancel.

Call Log Options
The following is a list of Call Log Options:

� Log all/unanswered incoming calls

� New call indication

� Preferred name match

� Area code set-up

� Name display format
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Table 2 describes the Call Log Options.  

Table 2: Call Log Options

Call Log Option Description Default value

Log all/unanswered 
incoming calls

Callers List logs all of 
the incoming calls or 
only the unanswered 
incoming calls. 

Log all calls

New call indication Telephone displays a 
message indicating that 
a new incoming call 
was received.

On

Preferred name 
match

If set to Off, the CPND 
from the Call Server is 
displayed for an 
incoming call. If set to 
On, the name stored in 
the Personal Directory 
is displayed, if there is 
a match.

Off

Area code set-up Incoming-call phone 
numbers display in the 
order you set, if the 
area code matches one 
of the three that you 
have set up. Example: 
area code first or area 
code last.

No area code 
specified

Name display format You can define the 
format of the name 
displayed for incoming 
calls. The two choices 
are: first name/last 
name or last name/first 
name

First name/last 
name
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To set Call Log Options:

1. Click the Services button.

2. Click Telephone Options.

3. Click Call Log Options.

4. Click one of the following:

� Incoming Calls

� Preferred Name Match

� Area Code Setup

� Name display format

5. Scroll through the selected list.

6. Click your selection.

7. Click Select or Cancel.

Personal Directory
You control your own Personal Directory. You can create up to 100 
entries. You can edit, copy, or delete individual entries, or delete the 
entire list, and you can copy entries from other applications to Personal 
Directory or from Personal Directory to other applications.

The following list describes the contents of a Personal Directory entry:

� last name (up to 24 characters)

� first name (up to 24 characters

� DN at work (up to 31 characters)

� DN at home (up to 31 characters

� cell phone (up to 31 characters)

� pager (up to 31 characters)
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Call Log features: Redial List and Callers List
Redial List and Callers List are Call Log features. The content of Redial 
List and Callers List is generated by the system during call processing. 
You can delete individual entries or the entire directory in Redial List and 
Callers List, but you cannot add an entry or permanently change the 
content of an entry.

Callers List
The Callers List can contain up to 100 entries. When the list is full, the 
system overwrites the oldest entry. 

In Directory View mode, the caller�s name displays along with the Callers 
List entry count. Entries in the Callers List are sorted by Call Log time. 
The first entry you see is the first new entry. If you press the down 
navigation key, more new items in the Callers List display. If you press the 
up navigation key, an older item in the list displays. 

The following list describes the contents of a Callers List entry:

� last name (24 characters)

� first name (24 characters)

� DN (31 characters)

� time/date

� number of calls

Redial List
The Redial List can contain up to 20 entries. When the list is full, the 
system overwrites the oldest entry.

In Directory View mode, the number you dialed is displayed. Redial List 
content is updated when you dial out. Entries in the Redial List are sorted 
by Call Log time. The oldest entry is at the beginning of the list. Press the 
down navigation key to go to the newest entry and press the up 
navigation key to go to the oldest.
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The following list describes the contents of a Redial List entry:

� user name (up to 24 characters)

� the DN (up to 31 characters)

� the time of the last call occurrence

� time/date

Password Administration
The Password Administration feature is available on the Directory list. 
The Station Control Password (SCPW) protects your private directory 
information. You can perform Password Administration from your 
IP Softphone 2050 once your SCPW is defined by your system 
administrator on the Call Server. This includes turning password 
protection on or off and changing your password.

When password protection is enabled, authentication is required before 
you can access Personal Directory, Redial List, or Callers List. You are 
prompted to enter your password in order to gain access to any of the 
password-protected features, like Personal Directory, Redial List, Callers 
List, or Virtual Office.

Note: The default setting for Password Protection is Off.

To turn Password Protection On/Off:

1. Click the Directory button.

2. Select Change Protection mode. If Password Protection is enabled, 
you are prompted to enter your password.

3. Click one of the following:

� Ent to confirm

� Del to delete your password

� Clr to clear your password

� Can to cancel and return to the Directory list
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4. If you clicked Ent, select one of the following:

� Enable Pwd Protection

� Disable Pwd Protection

5. Click one of the following:

� Yes to accept your selection

� No to return to the Directory list

6. If you selected Yes, click Done to enable or disable Password 
Protection.

To change your password:

1. Click the Services button.

2. Select Telephone Options (you will be prompted to enter your 
password).

3. Enter your password.

4. Select New Password.

5. Click one of the following:

� Sel to select New Password

� Del to return to the previous menu

� Clr to clear your password

� Can to end

If you clicked Sel, you are prompted to enter a new password.

6. Enter your new password and press Sel. You are prompted to 
confirm your new password.

7. Click one of the following:

� Sel to select New Password

� Del to return to the previous menu

� Clr to clear your password

� Can to end

If you clicked Sel, your password is changed.
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If you make three consecutive incorrect password attempts within an 
hour, you are locked out of the password-protected features for an hour. 
�Locked access� displays on your telephone. If Virtual Office is enabled, it 
is locked out. If you fail to access Virtual Office with incorrect password 
attempts, your access to other password-protected features is also locked 
out.

Your system administrator can reset and unlock your access at any time if 
you have been locked out or have forgotten your password.

Application Server Administration
This feature is available for your system administrator. The Personal 
Directory, Redial List, and Callers List features use a separate, central 
database, called the Application Server, to store directory data and user 
profile options. Backup and restoration of the database can be performed, 
and user profiles can be managed, by your system administrator using 
the Application Server Administration feature. 

System Tray icon and menu

The IP Softphone 2050 System Tray enables you to manage your phone 
calls and messages without opening the main IP Softphone 2050 window. 

If the IP Softphone 2050 window is minimized on the Taskbar, click either 
the IP Softphone Taskbar icon or the System Tray icon to view it. 

Right-click the System Tray icon to open a pop-up menu that enables 
you to make, answer, or manage your calls.
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Installing and setting up the 
IP Softphone 2050

System requirements

To use the Nortel Networks IP Softphone 2050, you need:

� Pentium-compatible CPU (200 MHz or higher)

� 128 Mbytes RAM (Microsoft Windows 2000)

� 64 Mbytes RAM (Microsoft Windows 98)

� 55 Mbytes free hard drive space (all languages)

� 800X600 resolution monitor (16-bit color)

� Universal Serial Bus (USB) port

� Nortel Networks USB Audio Kit

Supported operating systems
To use the IP Softphone 2050 you must have one of the following 
operating systems:

� Microsoft Windows XP

� Microsoft Windows 2000 Professional

� Microsoft Windows 2000 Professional Service Pack 1

� Microsoft Windows 2000 Professional Service Pack 2

� Microsoft Windows 98

� Microsoft Windows 98 Second Edition

USB Audio Kit
You must have a Nortel Networks USB Audio Kit to use the Softphone. 
The USB Audio Kit enables you to hear and speak with your callers.

The USB Audio Kit includes:

� USB Headset Adapter
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� Installation Guide (English and French)

� USB cord

� Telephony-grade monaural headset

� Lower cordset with quick disconnect

Installing the IP Softphone 2050

Refer to IP Phones: Description, Installation, and Operation (553-3001-
368) or consult your system administrator.

Installing the USB Headset Kit

Follow these steps to install the USB Headset Kit:

1. Ensure that you have the proper system requirements as listed �USB 
Audio Kit� on page 31.

2. Call your system administrator, who may need to change some 
settings before you can connect the IP Softphone 2050 to the 
communication server.

3. Connect the coiled lower cord to the headset cord with the Quick 
Disconnect connector. Ensure the Quick Disconnect is securely 
fastened.

4. Connect the headset cord to the RJ9 jack on the adapter.

5. Connect the USB cable to the headset adapter and to one of the USB 
jacks on the back of your computer or USB hub.

The first time the headset adapter is plugged in, a delay occurs while the 
Windows operating system configures the device and locates appropriate 
driver software. During the installation, you may be prompted to supply 
the original Windows CD-ROM so that the Windows operating system can 
locate drivers.

For more information on installing the IP Softphone 2050 software, 
contact your system administrator.



Managing contacts with the IP Softphone 2050

33

Managing contacts with the 
IP Softphone 2050

Adding contacts

You can add contacts to the Local Directory in the Main Group, or to any 
group on the Shortcut Bar.

To add a contact to the Local Directory:
1. Do one on the following: 

� Click the Main Group and click the Local Directory.

� Click the Group in the Shortcut Bar you want to add contacts to. 
You can click Main, Quick Dials, or any custom group that you 
created.

2. Click File > New Contact... or click the New Contact toolbar button. 
The Properties dialog box appears.

3. On the Business tab (which is selected by default), enter the 
contact�s name, address, telephone numbers, and other personal 
information.

4. Select the e-mail address tab and enter the contact�s e-mail 
address.

5. Select the Notes tab and enter notes or miscellaneous information.

6. Select the Settings tab and select the contact�s default telephone 
number and assign multimedia (sound and graphic) call 
announcements.

7. Click Save.

Note 1: You cannot add contacts to external directories, such as an 
LDAP directory in Local Directory mode.

Note 2: If the contents of an external directory has changed, you 
must update the directory before you can see the changes in the 
IP Softphone 2050 Local Directory. To update the directory, right-
click the imported directory and then click Refresh.
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You can add contacts to the Personal Directory, which is stored on the 
Application Server.

To add a contact to Personal Directory:
1. Click the Directory button.

2. Click Personal Directory.

3. Click the Add key to start a text editor.

4. Enter the contact information. 

TIP: you can click the Pause softkey any time during data entry to 
add a pause in the number.

5. Click Done to submit the entry. 

You can also add contacts to the Personal Directory by copying entries 
from the Corporate Directory, the Redial List, the Callers List, or other 
available directory applications. If you are creating multiple entries in the 
Personal Directory, you can make and edit multiple copies in an existing 
entry.

Editing contacts

You can edit contacts in all of your directories.

To edit a contact in the Local Directory:
1. On the Call Control window click, Application menu.

2. Click Local Directory.

3. Click one of the following:

� Local Directory 

� View Local Directory

4. Find and click the contact you want to edit.

5. Do one of the following:

� Click File > Properties.

� Click the Properties toolbar button.
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6. Select each tab and edit the information.

7. Click Save.

To edit a contact in the Personal Directory:
1. Click the Directory button.

2. Select Personal Directory from the Directory list.

3. Search for the desired entry.

4. Highlight the entry.

5. Click the Edit soft key and make the changes.

6. Click the Done soft key.

You can temporarily edit contacts in the Redial List and the Callers List, 
then dial the edited entry. The changes are not retained.

To temporarily edit a contact and dial it using the 
Redial List or the Callers List:
1. Click the Directory button.

2. Select Redial List or Callers List from the Directory list.

3. Search for the desired entry.

4. Highlight the entry.

5. Click the Edit soft key and make the changes.

6. Click the Dial soft key to dial the edited entry.

Deleting contacts

You can delete contacts in your Local Directory.

To delete a contact in the Local Directory:
1. On the Call Control window, click Application.

2. Click Local Directory. 
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3. Click one of the following:

� Local Directory 

� View Local Directory 

4. Find and click the contact you want to delete. 

Note: To delete a range of contacts, click the first contact in the range 
and then shift-click the second contact in the range. You can also 
CTRL-click to select contacts.

5. Click File.

6. Click one of the following:

� Delete 

� the Delete toolbar button.

7. Click Yes to confirm the deletion.

You can delete contacts or the contents of the entire directory for 
Personal Directory, Redial List, or Callers List.

To delete a contact in Personal Directory, Redial 
List, or Callers List:
1. Click the Directory button.

2. Select the Personal Directory, Redial List, or Callers List.

3. Search for the entry.

4. Highlight the entry.

5. Click the Delete soft key.

6. Click the Confirm or Cancel key.

To delete the Redial List or Callers List:
1. Click the Directory button.

2. Select Redial List or Callers List.

3. Click the Del soft key.

4. Click Yes.
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Finding contacts

You can search for contacts in your Local Directory using any of the edit 
creation criteria.

To find a contact in one of your directories:
1. On the Call Control window, click Application.

2. Click Local Directory.

3. Click one of the following:

� Local Directory

� View Local Directory

4. Find and click the directory you want to search in.

5. Click File.

6. Click one of the following:

� Find Contact... 

� Find Contact toolbar button.

7. Enter your search criteria. 

Note: You can enter the name, e-mail address, or phone number. 
Remember to enter it the way it appears in the directory. For 
example, the name should be in the format, �last name, first name.�

8. Click Find Now. The dialog box expands to display a list of the 
contacts that fit your search criteria.

9. To stop a search, click Stop.
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You can find contacts in Personal Directory, Redial List, or Callers List 
using the following methods.

To find contacts in Personal Directory, Redial List, or 
Callers List:
1. Click the Directory button.

2. Click the desired directory and do one of the following:

� Scroll through the directory to the desired entry. 

� Enter the number of the entry to go directly to it.

� Search by first name, last name, or number.

Filtering a directory

The IP Softphone 2050 directory enables you to filter directories. Filtering 
makes directories smaller and easier to manage and use. This feature is 
especially useful for dealing with large, cumbersome directories. For 
example, by filtering a directory you can greatly reduce the number of 
names you have to search through.

To filter a directory:
1. Select the directory you want to filter in the Shortcut Bar.

2. Click the Filter toolbar button. The Filter dialog box appears.

3. Add your filter criteria.

4. Click OK.

Dialing from the Local Directory

You can dial numbers from the Local Directory.

To call a contact stored in the Local Directory:
1. On the Call Control window, click Application.

2. Click Local Directory.
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3. Click one of the following:

a. Local Directory 

b. View Local Directory.

4. Locate the contact you want to call, then do one of the following:

� Double-click the phone number you want to dial.

� Double-click the contact's name. 

� Click the Call Contact toolbar button to dial the default telephone 
number.

� Right-click the contact's entry and click the desired telephone 
number in the pop-up menu.

� Click the arrow beside the Call Contact toolbar button and click 
the desired telephone number in the pop-up menu.

Dialing from the Personal Directory

To dial from the Personal Directory:
1. Click the Directory button.

2. Scroll to the Personal Directory.

3. Click to open the Personal Directory.

4. Find the contact by one of the following:

� Scroll to the desired contact.

� Search for the contact by name or number.

� Enter the number of the contact to find it.

5. Double-click the contact to dial the selected entry.
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Dialing from the Redial List

You can dial from the Redial List:
1. Do one of the following to open Redial List:

� Click Redial List on the Toolbar in the Enhanced Call Control. 
window.

� Click the Directory button, and click Redial List.

2. Find the contact by one doing of the following:

� Scroll to the desired contact.

� Search for the contact by name or number.

� Enter the number of the contact to find it.

3. Double-click the contact to dial the selected entry.

Dialing from the Callers List

You can dial from the Callers List:
1. Do one of the following to open Callers List:

� Click Callers List on the Toolbar in the Enhanced Call Control 
window.

� Click the Directory button and click Callers List.

2. Find the contact by one doing of the following:

� Scroll to the desired contact.

� Search for the contact by name or number.

� Enter the number of the contact to find it.

3. Double-click the contact to dial the selected entry.
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Adding a group to the Shortcut Bar

You can add a group to the Shortcut Bar in your Local Directory.

To add a new group to the Local Directory:
1. Right-click a blank area on the Shortcut Bar.

2. Click Add New Group. A blank Group button appears with a blinking 
cursor at the bottom of the Shortcut Bar.

3. Enter the name you want for the group and press Enter.

To view the contents of a group click the group�s button.

Customizing the Shortcut Bar

To change the size of the Directory icons:

1. Right-click a blank area of the Shortcut Bar.

2. Click one of the following: 

� Large Icons 

� Small Icons

To change appearance of Shortcut Bar:
1. Right-click a blank area in the Shortcut Bar.

2. Click Properties. The Shortcut Bar properties dialog box appears.

3. Enter your custom settings.

4. Click OK.
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Properties dialog box

Use the Properties dialog box to enter or change contact information.

To open the Properties dialog box:
1. On the IP Softphone 2050 window, do one of the following: 

� Click Application menu > Local Directory > Local Directory.

� Click View > Local Directory. The Directory opens.

2. In the Local Directory window do one of the following:

� Click File > New Contact... 

� Click the New Contact toolbar button. 

� Click a contact and click File > Properties...

� Click the Properties toolbar button.

This dialog box contains four tabs:

� Properties - Business 

� Properties - E-mail address

� Properties - Notes

� Properties - Settings

Properties - Business tab
Use this tab to store a contact�s name, address, company information, 
and telephone numbers. To create a contact record, enter the contact�s 
name and at least one telephone number. All other information is 
optional.

Note: Inserting a comma in the telephone number inserts a 
0.5-second delay before dialing the numbers that follow the commas. 
Insert as many commas as required.
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Export button
This button exports the contact information to a *.vcf file. This file can then 
be imported into e-mail or contact manager applications, or other software 
applications that use the *.vcf file format.

Properties - Email Address tab
Use this tab to store e-mail information:

� Email address - Enter the contact�s e-mail address.

� Email type - Enter a label for the e-mail address. For example, 
�Personal e-mail account.�

Note: You cannot send e-mail using the Softphone.

Properties - Notes tab
Use this tab to record miscellaneous information about a contact. You can 
enter significant dates, recent orders, meeting locations, or any 
information you need to be available when you call the contact.

Properties - Settings tab
Use this tab to select which telephone number you dial by default. The 
Default Dial telephone number setting you specify here applies only to 
this contact.

Tip: You can dial a contact�s non-default telephone number by right-
clicking the contact and selecting any other telephone number that 
appears in the pop-up menu.
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Managing IP Softphone 2050 calls

Making telephone calls

Before making a call, ensure you are wearing your headset.

To make a call:
1. Select the line you want to use by clicking a Line key.

2. Choose one of the following methods to enter the phone number:

� Enter the phone number using the number pad on your keyboard. 

� Use the mouse and the IP softphone 2050 dial pad.

� Open a directory application, such as Personal Directory, Redial 
List, or Callers List, scroll through the directory, and double-click 
the number you want to dial.

Tip: To make a call on your prime telephone line, click the 
Answer/Handsfree button and dial the telephone number as 
described above.

Answering telephone calls

To answer a call, ensure you are wearing your headset. When you 
receive a call, you will hear the IP Softphone 2050 ringer through the 
Ringing Speaker and you will see Caller ID (if available) on the display 
area.

Note: The Ringing Speaker is the device you specify on the Select 
Sound Devices screen of the Configuration Utility.



Managing IP Softphone 2050 calls

45

To answer a call:
Do one of the following:

� Click the Answer/Handsfree button.

� Click the Line key of the ringing line.

 If you are on another call, that call is put on Hold.

Tip: To switch between callers, click the appropriate Line key.

Holding and retrieving telephone calls

To manage calls, ensure you are wearing your headset.

To put a call on Hold, or remove a call from Hold:
1. Click the Line key for the call.

2. Click the Hold button.

Hanging up telephone calls

You must terminate a call when it has ended.

To hang up a telephone call:
1. Click the appropriate Line key to ensure it is selected.

2. Click the Goodbye/Release key.
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IP Softphone 2050 USB Headset 
Adapter 

Overview

The features of the USB Headset Adapter are briefly described in Table 3. 
 

Table 3: USB Headset Adapter elements and functions (Part 1 of 2)

Element Function

Message Waiting 
light

The red Message Waiting light is located at the 
top of the USB Headset Adapter. This light has the 
same function as the Message Waiting light on the 
IP Softphone 2050 interface.

This light flashes when you have voicemail 
messages. On most systems, this light also 
flashes when a call is ringing on the IP Softphone 
2050.

Maximize button Press the Maximize button to maximize or 
minimize the IP Softphone 2050. 

If the IP Softphone 2050 is minimized, press this 
button to maximize the IP Softphone 2050 
window. 

If the IP Softphone 2050 is maximized, but behind 
another window, press this button to bring the 
IP Softphone 2050 to the foreground. 

If the IP Softphone 2050 is maximized, press this 
button to minimize the IP Softphone 2050.

i2050 Smart 
Functions button

Press this button to access the i2050 Smart 
Functions menu. For more information about the 
i2050 Smart Functions menu, refer to Using the 
i2050 Smart Functions button.
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Answering calls with the USB Headset 
Adapter

You can answer a call using the USB Headset Adapter even if the 
IP Softphone 2050 is minimized or in the background. 

To answer a call using the USB Headset Adapter:
1. Ensure you are wearing your headset.

2. Press the Answer button.

Answer button If you have an incoming call, press the Answer 
button to answer the call. 

If you have no incoming call when you press this 
button, the IP Softphone 2050 selects a line and 
you hear dial tone.

Release button Press the Release button to hang up the current 
call.

Mute button Press the Mute button to put a call on mute or 
take a call off mute. When you mute a call, you 
can still hear your caller, but your caller cannot 
hear you.

Mute light The Mute light is beside the Mute button. When a 
call is on mute, the Mute light is on. When a call is 
not on mute, the Mute light is off.

Volume button Use the Volume button to control the volume of 
the headset.

When the i2050 Smart Functions Menu appears, 
use these buttons to move up and down in the 
menu.

Table 3: USB Headset Adapter elements and functions (Part 2 of 2)

Element Function
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To view Caller ID information before you answer 
the call if IP Softphone 2050 is minimized or in 
background:
1. Ensure you are wearing your headset.

2. Press the Maximize button to display the IP Softphone 2050 
interface.

3. Press the Answer button. 

Hanging up calls with the USB Headset 
Adapter

You can hang up a call using the USB Headset Adapter even if the 
IP Softphone 2050 is minimized or in the background. 

To hang up a telephone call using the USB Headset Adapter, press the 
Release button.

Adjusting the volume with the USB Headset 
Adapter

You can easily adjust the volume of your telephone calls using the USB 
Headset Adapter. Ensure you are wearing your headset so you can hear 
the changes as you make them.

To decrease the volume, press the left side of the Volume button. 

To increase the volume, press the right side of the Volume button. 

Muting a call

When you mute a call, you can still hear your caller, but your caller cannot 
hear you.

To mute a call using the Headset adapter, press the Mute button.
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Using the i2050 Smart Functions menu

The i2050 Smart Functions menu provides quick access to 
IP Softphone 2050 features. You can customize what appears on this 
menu using the i2050 Configuration Utility.

To access the i2050 Smart Functions menu:
1. Press the i2050 Smart Functions button on the USB Headset 

Adapter.

2. Highlight the feature you want by using one of the following:

� the mouse

� the keyboard arrow keys

� the Volume button on the USB Headset Adapter 

3. To select the feature, do one of the following:

� Click the OK button.

� Press the i2050 Smart Functions button on the USB Headset 
Adapter.

If the i2050 Smart Functions menu displays only one feature, the 
Don't display this dialog again check box appears. If you select this 
check box, the i2050 Smart Functions menu does not appear when you 
press the i2050 Smart Functions button. Instead, the feature on the 
i2050 Smart Functions menu is automatically executed when you press 
the i2050 Smart Functions button.

Customizing the i2050 Smart Functions 
menu

You can customize the features that appear on the i2050 Smart Functions 
menu using the i2050 Configuration Utility. 

To customize the i2050 Smart Functions menu:
1. Click the Start button. 

2. Click Settings.
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3. Click Control Panel.

4. Double-click the IP Softphone 2050 icon.

5. Click the USB Headset Adapter tab.

6. Click the Configure Smart Functions button. 

7. Click the OK button to close the Configure Smart Functions dialog 
box.

8. Click the OK button to close the i2050 Configuration Utility.

Use the procedures below to change the functions that are available.

To add a function:
1. On the Available functions list, click the function you want to add.

2. Click the Add button.

3. Click the OK button to close the Configure Smart Functions dialog 
box.

4. Click the OK button to close the i2050 Configuration Utility.

To remove a function:
1. Click the function you want to remove.

2. Click the Remove button.

3. Click the OK button to close the Configure Smart Functions dialog 
box.

4. Click the OK button to close the i2050 Configuration Utility.

To rearrange the functions on the menu:
1. Click the function you want to move up or down on the i2050 Smart 

Functions menu.

2. Do one of the following:

� Click the Move Up button to move the function to a higher 
position on the menu.

� Click the Move Down button to move the function to a lower 
position on the menu.
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You can also add special functions to the i2050 Smart Functions menu. 
For information about adding special functions, refer to Custom Functions 
for i2050 Smart Functions menu.

Custom Functions for i2050 Smart Functions 
menu

From the Configure Smart Functions dialog box, you can add, delete, and 
modify custom functions on the i2050 Smart Functions menu.

To add a custom function:
1. Click the New button.

2. In the Name box, enter the name you want to appear on the i2050 
Smart Functions menu.

3. In the Command box, enter the pathname and file name of the 
function you want to add.

Note:  If you do not know the pathname or file name of the function, 
click the Browse button beside the Command box. You can then 
navigate to the correct file, select it, and click the Open button.

4. In the Arguments box, enter any arguments that are required for this 
function.

Note: If you want the IP Softphone 2050 to prompt you for the 
argument when you select this special function, select the Prompt 
for arguments check box.

5. In the Initial directory box, enter the pathname of the directory you 
want this function to use. 

Note: If you do not know the pathname of the directory, click the 
Browse button beside the Initial directory box. You can then navigate 
to the correct directory, select it, and click the OK button.

6. To change the icon that appears beside this function on the i2050 
Smart Functions menu, click the Change icon and perform steps 7 to 
9. If you do not want to change the icon, go to step 10.

7. Click the Browse button.



IP Softphone 2050 USB Headset Adapter

52

8. Navigate to the file you entered in the Command box and select it.

9. Click the Open button.

10. Click one of the icons that appears.

11. Click the OK button.

12. Click the OK button to add the new function to the i2050 Smart 
Functions menu.

To modify a custom function:
1. Click the custom function you want to modify.

2. Click the Modify button.

3. Make the required changes.

4. Click the OK button.

To remove a custom function:
1. Click the custom function you want to remove.

2. Click the Delete button.

3. Click the Yes button to confirm the deletion.
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IP Softphone 2050 macros

About macros with the IP Softphone 2050

The IP Softphone 2050 enables you to record macros. A macro is a 
recorded sequence of steps that can be used to automate repetitive 
actions. For example, you can program a macro that selects a particular 
telephone line and then dials a telephone number automatically or 
macros that ensure certain numbers are always dialed out on a particular 
telephone line.

To access the IP Softphone 2050 Macro menu from the Standard Call 
Control window, click the Macro menu. 

To access the IP Softphone 2050 Macro menu from the Enhanced Call 
Control window, click Application menu > Macro.

Once you have recorded a macro, it is saved under the Macro menu.

Recording a macro

You can record a macro to automate a procedure or repetitive action.

To record a macro:
1. Click the Macro button.

2. Click New.

3. Enter the name of your new macro.

4. Click Record.

5. Enter the keystrokes to complete the action or procedure.

6. Click Add to add the new macro to the macro list.

TIP: You can insert a short pause in the macro by using the Pause 
key. A pause introduces a delay which may be required to access 
some Interactive Voice Response applications and the voicemail 
systems.
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Note: If you started recording a macro but you do not complete this 
function, click the Abort button at the bottom of the Call Control 
window.

Deleting a macro

You can delete a macro.

To delete a macro
Record a new macro over the existing macro.

Playing a macro 

You can play macros to dial telephone numbers or access your voicemail. 

To play a macro:
Do one of the following:

� Click Macro > [Macro name].

� Click Application menu > Macro > [Macro name].
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IP Softphone 2050 menu 
commands 

Enhanced Call Control window menu

The Application menu provides access to the Enhanced Call Control 
window.

To access the Enhanced Call Control window:
1. Click Application Menu.

2. Select Skin.

3. Select Enhanced. 

 Following are the items in the Enhanced Call Control window menu:

� Trays � Selects the information that appears on the Enhanced Call 
Control window.

� Retract Tray - Displays no additional information, so the 
Enhanced Call Control window takes up less space.

� Lines - Displays the Line keys in two columns.

� Number Pad - Displays the dialpad.

� Combo - Displays the Line keys and the dialpad.

� Configure Audio � Specifies the sound device you want to use with 
the IP Softphone 2050. A sound device such as the USB Audio Kit 
enables your computer to send and receive audio (sound) signals.

� Select Skin � Selects a Call Control window: Standard or Enhanced.

� Select Language � Selects the language that is used on the 
IP Softphone 2050.

� Local Directory � Opens the Local Directory.

� Redial List - Opens the Redial List.

� Callers List - Opens the Callers List.

� Macro [Name] � Executes the macro you saved in this command.
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� Record � Starts recording a macro.

� Help � Opens the IP Softphone 2050 Help window.

� About � Displays information about the IP Softphone 2050.

� Exit � Closes the Call Control window, but does not disconnect your 
computer from the telephony server so you can still receive telephone 
calls (the i2050srv application remains running in the background).

Standard Call Control window menu

The Standard Call Control window menu contains the following items.

� Configure Audio � Specifies the sound device you want to use with 
the IP Softphone 2050. A sound device such as the USB Audio Kit 
enables your computer to send and receive audio (sound) signals.

� Select Skin � Selects a Call Control window: Standard or Enhanced.

� Select Language � Selects the language that is used on the 
IP Softphone 2050.

� Exit � Closes the application.

View menu

The View menu contains the following items:

� Local Directory � Displays the Local Directory.

� Message Waiting � Shows or hides the Message Waiting Light.

� Toolbar � Shows or hides the Toolbar.

� Primary Display � Shows or hides the Primary Display.

� Compact Lines � Displays the IP Softphone 2050�s Line keys in two 
columns so that the main window takes up less space.

� Numeric Pad and Lines � Displays the Dial Pad and the Line keys in 
one column.

� System Tray � Shows or hides the IP Softphone 2050 task tray icon. 
Right-click this icon to make or manage telephone calls.
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Macro menu

The Macro menu contains the following items.

� Macro [Name] � Executes the macro you saved in this command.

� Record � Starts recording a macro.

� Abort � Stops recording a macro.

Help menu

The Help menu contains the following items.

� Contents � Displays the help topics.

� Search � Searches the help topics for a word or phrase.

� Index � Displays the index for the help topics.

� What's This? � Activates Context Sensitive Help. After selecting this 
command, click any area of the screen to see help information about 
it.

� About � Displays information about the IP Softphone 2050.
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Troubleshooting the 
IP Softphone 2050

Application interoperability issues

Some applications do not properly check versions of shared system files 
at installation time. This can cause interoperability problems between the 
IP Softphone 2050 and other applications.

For example, installing Timbuktu version 2.0 for Windows 2000 
overwrites a .dll file that is also used by the IP Softphone 2050. The 
IP Softphone 2050 requires the newer version of the .dll and installs this 
newer version if necessary. To use the IP Softphone 2050 on the same 
computer as version 2.0 of Timbuktu, you must install Timbuktu first.

The IP Softphone 2050 follows Windows and Install Shield standards for 
version management of system files.

Connectivity problems

Communication Server is unreachable

Symptom:
One of the following messages appears:

� Connecting...

� Server unreachable. Reconnecting in xx seconds.

� 802.1 QoS is not supported on your network.

Description:
These messages indicate that the connection with the communication 
server could not be established. A random retry time is set, after which 
the IP Softphone 2050 attempts to re-connect. This process is repeated 
until the IP Softphone 2050 is successfully connected.
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If the communication server is up and reachable and the 
IP Softphone 2050 is pointed to the correct IP address, the 
�Connecting...� message appears briefly (or not at all).

The �Server unreachable� message indicates that there is a problem 
contacting the communication server.

Potential causes:
� Network is down.

� Computer is not connected to the network.

� Invalid communication server settings in the Configuration Utility.

� Invalid communication server settings in DHCP configuration.

� Communication server is down.

Action:
� Ping another station on the network.

� Ping the communication server.

� Use the Configuration Utility to verify the communication server 
IP address and port number.

� Verify that the communication server configuration is correct (a port is 
available, a license is available, security is correct). 

� In the IP Softphone 2050 Configuration Utility QoS tab, select Off, 
then restart the IP Softphone 2050 application.

Connection is reinitializing

Symptom:
The following message appears: �Connection Established. 
Reinitializing...�

Description:
This message indicates that the IP Softphone 2050 has established a 
connection and has sent a request to the communication server to 
resume connection. The communication server is expected to reply to this 
request. Some communication servers pass the IP Softphone 2050 to 



Troubleshooting the IP Softphone 2050

60

different sub-components, causing this message to appear two or three 
times in rapid succession during a normal startup.

Potential causes: 
� If the message appears briefly, this is part of a normal startup.

� If the message persists, the communication server programming may 
be in error. 

Action: 
Wait to ensure that this message is not a transient startup message. If the 
message still appears, ensure your communication server programming 
is correct.

Authorization failed

Symptom:
The following message appears: �Authorization failed�.

Description:
Client has not been authorized to use the communication server. 

Potential causes: 
� The client has not been authorized by your system administrator. 

� The HardwareID in your configuration (Configuration Utility) does not 
match the HardwareID provisioned for the communication server.

Action: 
Contact your system administrator.

Unable to retrieve communication server 
parameters from DHCP server

Symptom:
The following message appears:�DHCP server is not available�.

Description:
A connection with the DHCP server cannot be established.
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Potential causes:
� Network is down

� DHCP server configuration error

Action: 
Contact your system administrator.

Service denied

Symptom:
The following message appears:�Service Denied. Reason XXXX �.

Description:
You are not authorized to use the communication server. 

Potential causes: 
� Invalid HardwareID in the Configuration Utility 

� Invalid communication server configuration

Action: 
� Ensure your communication server programming is correct.

� Contact your system administrator.

Display updates are very slow

Symptom:
� Cannot connect properly to the communication server

� Messages written to the IP Softphone 2050 appear very slowly.

� Floppy drive may be active.

Potential causes: 
The Trace utility may be turned on and writing signaling information to a 
slow disk such as a floppy drive.

Action: 
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� The Trace feature should be disabled (unchecked) during normal 
operation. To check the status of the Trace feature, open the 
Configuration Utility and then open the Trace tab.

� If you are using the Trace feature, the specified directory should be 
on a local, high-speed disk drive.

Audio problems

Verify basic audio operation
To verify the physical connection and proper Windows audio 
configuration, record an audio message and play it back using the USB 
headset.

One-way audio
Check that the handsfree option has been programmed for the 
IP Softphone 2050 on the communication server.

Check if the mute option has been turned on. If the mute option is on, the 
Mute button appears red on the IP Softphone 2050 interface.

Check that Network Address Translation (NAT) device is used in the 
system. If so, check the NAT configuration. You will get one-way audio if 
the NAT configuration causes the IP Softphone 2050 to attempt to 
connect to the wrong IP address.

Broken or choppy speech
The Audio Quality slider adjusts the number of buffers between the 
computer audio device and the IP Softphone 2050 application. Less delay 
reduces the audio delay but increases the chances of getting broken or 
absent audio. Higher quality reduces the chance of broken audio but 
increases audio delay.

If you are receive choppy or broken speech, move the Audio Quality 
slider toward Higher Quality.

The Windows operating system uses very high process and thread 
priorities when performing low-level Windows operations, such as 
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minimizing and maximizing applications. This can cause brief breaks in 
the IP Softphone 2050 audio streams. 

To reduce the severity of this symptom, turn off the Windows transition 
effects for menus and tool tips. 

To turn off the Windows transition effects:
1. Click the Start button.

2. Click Settings.

3. Click Control Panel.

4. Click Display.

5. Select the Effects tab.

6. Clear the Use transition effects for menus and tool tips check box.

Other causes of audio issues
Other applications running on your computer, especially CPU-intensive 
applications or applications that intercept or delay packets (such as 
firewalls), can cause broken audio.

Multiple Ethernet interfaces on a single PC may not work well together. 
For example, the IP Softphone 2050 may exhibit intermittent breaks in 
audio when using notebooks that have a Xircom RealPort Cardbus 
Ethernet 10/100+Modem 56 PC Card (PCMCIA) inserted when the 
notebook is docked. In the specific case of this PC card, the problem 
relates to a version of the Xircom driver. This driver takes CPU cycles 
even when it is not active and this, in turn, causes IP Softphone 2050 
audio to become choppy. 

Solutions for this example are:

1. Upgrade your Xircom driver.

2. Remove the PC card when the notebook is docked.

To upgrade your Xircom driver: 

1. Download and install a new PC card driver from the Xircom web site. 

2. Follow the installation instructions provided by Xircom.

Note: You require administrator privileges on Windows 2000.
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Windows sound comes out of the headset

Description:
Windows sound comes out of the headset, but you want Windows sound 
to come out of the loudspeakers and the Softphone audio to come from 
the headset.

Action:
In some cases, the Windows operating system defaults all the sounds to 
the new sound device.

If you want to use the computer speakers for playing the Windows 
sounds:

1. Click the Start button.

2. Click Settings.

3. Click Control Panel.

4. Click Sounds and Multimedia.

5. Select the Audio tab.

6. Select Sound Playback Preferred device. 

7. From the drop-down list, select your computer sound card. (Select 
your computer�s Sound Recording Preferred device as another 
device if you do not wish to use the Headset Adapter for this 
purpose.)

Advanced audio settings
Under normal conditions, you should always select the option 
Use Communication Server values. When you choose this option, the 
IP Softphone 2050 uses the jitter buffer parameters sent from the 
communication server.

You can override these settings by selecting the Override 
Communication Server. Nortel Networks recommends that you do not 
use this option.



Troubleshooting the IP Softphone 2050

65

Reset conditions

The IP Softphone 2050 resets when:

� instructed to do a hard reset by the communication server

� you change the IP Softphone 2050 skin

� firewall applications intercept or delay packets causing the 
IP Softphone 2050 to reset due to the expiration of the Watchdog 
timer

Note: Use care when using firewall applications on the same 
computer as the IP Softphone 2050.

� excess delay or loss of communication with the server occurs

USB Headset problems

Headset not functioning
Try the following in the order presented:

1. Verify that you have a supported operating system. To check the type 
of operating system you are using, from the PC desktop, right-click 
the My Computer icon and then click Properties.

2. Ensure that Universal Serial Bus controllers appears in the Windows 
Device Manager. If it does not appear, you might need to enable USB 
in your computer�s setup menus or get a BIOS upgrade. Contact your 
computer supplier.

3. Ensure that USB Audio Device appears under �Sound, video and 
game controllers� in the Windows Device Manager. Also ensure that 
HID-compliant device and USB Human Interface Device appears 
under Human Interface Devices. If they do not, and the above 
conditions are correct, see the USB Troubleshooting section in 
Windows Help.

4. Ensure that you have selected USB Audio Device as the microphone 
and speaker for the Softphone.
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USB Headset Adapter features grayed out

Symptom:
All of the features on the USB Headset Adapter tab in the i2050 
Configuration Utility are grayed out.

Description:
The adapter is not recognized as a Nortel Networks USB Headset 
Adapter or the version of the USB Headset Adapter is earlier than 2.0.

Potential causes:
1. The USB Headset Adapter does not support the functions listed on 

the USB Headset Adapter tab.

2. The USB Headset Adapter has failed to enumerate properly.

Action:
If you suspect potential cause 2, do the following:

1. Unplug the USB cable from the USB Headset Adapter.

2. Wait one minute.

3. Plug the USB cable into the USB Headset Adapter. This forces the 
USB Headset Adapter to re-enumerate. 

Cannot hear audio through headset
Ensure that the headset plugged into the USB adapter is provided by the 
manufacturer.

Check the connectors for a loose connection.

Sound still comes out of my computer speakers

Description:
The IP Softphone 2050 is not configured to direct all call audio to the 
headset.

Action:
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Configure the USB Headset by doing the following:

1. Go to the IP Softphone 2050 Call Control Window. 

2. Click Application Menu.

3. Click Configure Audio.

4. Select Headset Microphone.

5. Choose USB Audio Device from the drop-down list.

6. Choose Headset Speaker.

7. Choose USB Audio Device from the drop-down list.

8. Chose Ringing Speaker.

9. Choose the desired device from the drop-down list.

10. Click OK.

Directory problems

Redial List and Callers List must be available on your Call Server, and the 
appropriate class of service must be enabled, in order for you to use 
them. If you cannot access Redial List or Callers List contact your system 
administrator.
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Mobile Voice Client 2050 
overview

Designed to work with your personal digital assistant (PDA) and IP-based 
telephone systems, the Mobile Voice Client (MVC) 2050 provides real-
time voice service over the Internet. 

The MVC 2050 supports several features, including the following:

� 6 programmable line/feature keys

� 4 soft keys (self-labeled)

� 12-button dialpad

� multi-field display

� end user-selectable skins

� directory capabilities including Personal Directory, Redial List, and 
Callers List

To make a call from your PDA using the MVC 2050, you can dial with 
your dialpad, use a macro, or use Paste to copy a number from another 
application. You can also use one of the methods on your PDA System 
Input Panel. 

If you are using Microsoft®  Windows Mobile� 2003 as your operating 
system, the MVC 2050 can also coexist with a secure Virtual Private 
Network (VPN) client such as certicom� movianVPN� or 
Apani�Networks, for connection to a business network. 

The MVC 2050 functions like the IP Softphone 2050. However, the 
MVC 2050 cannot be used as an Agent or Supervisor in Call Center 
Portal applications.
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Software dependencies

The following are the MVC 2050 primary software dependencies: 

� Windows Mobile 2003

� GIPS NetEQ (included with the MVC 2050 software)

� VPN client (for secure access to a network)

For secure (VPN) access to a network, a VPN client is required. The 
Certicom� movian� VPN client and the Apani� Networks VPN client 
have been tested with the MVC 2050. 

Supported PDAs

The following is a list of PDAs supported for use with the MVC 2050:

� Dell® Axim® X5

� Dell Axim X3/C3i

� Hewlett Packard® iPAQ® h5550/h5555

� Toshiba e750/e755

� Toshiba e800/e805

Note: Dell Axim X3, 300 MHz PDA model, is not supported for use 
with the MVC 2050. Since the PDA industry evolves at a rapid pace, 
contact Nortel Networks technical support to determine the latest 
PDA models tested and supported, and any known issues.

PDA processor models, speed, and amount of memory vary. To maintain 
audio quality, do not overload the processor with intensive tasks while 
using the MVC 2050. For example, Nortel Networks does not recommend 
using your PDA version of the Internet browser while using the MVC 
2050.

PDA vendors offer two types of rechargeable battery: standard and 
extended-life. The extended-life battery is recommended to provide 
longer call duration and increased call volume.
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Headsets

A headset is required in order to send and receive telephone calls using 
the MVC 2050 and your PDA. The headset is an important part of audio 
quality. 

MVC 2050-compatible iPAQ and Toshiba PDAs support stereo 
headphones and microphones like Plantronics M130 Adjustable Fit 
Headset, which is iPAQ-certified.

The Dell MVC 2050-compatible PDA supports a stereo headphone but 
not a microphone. 

Contact your PDA vendor to obtain headset recommendations.

For more information about Automatic Gain Control, see �MVC 2050 
configuration� on page 77.

CAUTION

MVC 2050 does not support Bluetooth 
headsets.
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MVC 2050 menus and screen features

The MVC 2050 software provides menus and screen features to your 
PDA. Table 4 lists the MVC 2050 menus and their selections. 

See also �Mobile Voice Client 2050 Call Handling screen� on page 79 and 
�Menu and icon summaries� on page 99.  

Table 5 on page 72 describes the MVC 2050 screen features. See also 
�Mobile Voice Client 2050 Call Handling screen� on page 79.  

Table 4: MVC 2050 menus

Menu Selections

File Run in background, Paste, Contacts, Settings, 
Exit

Keys Headset, Answer, Goodbye, Hold, Features, 
Macros

Help Diagnostics, Contents, About

Note: Keys > Features and Keys > Macros selections in Table 4 also 
provide pop-up menus.
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Table 5: MVC 2050 screen features

Screen features Selections

Call Handling icons Hold, Answer/Headset, Release

Toolbar The retractable toolbar contains keys that are 
not present on the remainder of the display. 

They are: Directory, Messages, Shift, 
Services, Expand, Copy, Exit, Redial List, and 
Callers List. 

The toolbar can be shown or retracted using 
the Toolbar icon on the menu bar. See 
Figure 18 on page 93.

Mute, Volume Up, and Volume Down icons 
are also present on the Toolbar and appear on 
the skin when the Toolbar is retracted. 

Toolbar icons Directory, Messages, Shift, Services, Expand, 
Copy, Quit, Callers List, Redial List

Menu Bar icons Paste, Contacts, Settings, Toolbar

Navigation The up, down, left, and right cursor control 
arrow keys are mapped to the hardware 
navigation buttons on the PDA hardware. 
These buttons are used for cursor control.
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Figure 3:  Call Handling screen (with Toolbar retracted)
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Installing and configuring the 
Mobile Voice Client 2050

To install MVC 2050 on your PDA:

1. If you have an older version of MVC 2050 installed on your PDA, you 
must remove it prior to installing a newer version. See Removing a 
previous version of MVC 2050.

2. Place your PDA in its cradle.

3. Synchronize your PDA with a desktop PC running Microsoft 
ActiveSync. See �Connecting a PDA to a desktop PC using 
ActiveSync� on page 75.

4. Install the MVC 2050 from a Desktop. See �Installing the MVC 2050 
from a Desktop PC using ActiveSync� on page 76.

Removing a previous version of MVC 2050

If a previous version of the MVC 2050 is installed on your PDA, delete the 
old version before installing the new one, or the installation fails. See 
Figure 4 on page 75.

Use the following procedure to remove the MVC 2050 from your PDA:

1. Select Start from the Main Application screen. A drop-down menu 
appears.

2. Select Settings. The Settings dialog box appears.

3. Select the System tab. The System dialog box appears. 

4. Select Remove Programs. A list of programs appears.

5. Select Mobile Voice Client 2050.

6. Select Remove. A dialog box appears, asking you to confirm this 
decision.

7. Select Yes. A brief pause occurs while the PDA removes MVC 2050. 
After the pause, a dialog box appears asking if you want to perform a 
soft reset.

8. Select Yes. Your PDA restarts.
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Figure 4:  Removing MVC 2050

MVC 2050 installation method

The MVC 2050 supports installation from a docked PDA with a Microsoft 
ActiveSync connection to a desktop PC.

Connecting a PDA to a desktop PC using ActiveSync
Use the following procedure to synchronize your PDA to your 
desktop PC:

1. Place your PDA in its cradle.

2. Ensure that ActiveSync is running. Connection is confirmed on the 
ActiveSync screen.

3. Wait for the two PCs to synchronize. Synchronization is confirmed on 
the ActiveSync screen.

See Figure 5 on page 76. For details about synchronization, refer to the 
Users Manual for your PDA.
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Figure 5:  ActiveSync connected

Installing the MVC 2050 from a Desktop PC using 
ActiveSync
Use the following procedure to install MVC 2050 using the CD:

1. Insert the MVC 2050 CD into the CD-ROM drive of your desktop PC.

2. Go to your desktop and double-click My Computer.

3. Select the CD Drive.

4. Select Setup.

5. Follow the instructions on the screen. The Install Wizard displays a 
message asking you if you want to modify, install, or remove the MVC 
2050.

6. Select Install. The Install Wizard installs the MVC 2050. When the 
installation finishes, a message appears on the PC�s display 
requesting that you attend to your device (PDA) and a message 
appears on the PDA�s display asking you if you want to perform a soft 
restart.

7. Select Yes. Your PDA restarts with the new version of the MVC 2050.
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MVC 2050 configuration

Enable ClearType
The MVC 2050 uses a special screen font which requires that 
ClearType® be enabled on your PDA. 

To enable ClearType:

1. From the PDA�s Main Application screen, select Start.

2. Select Settings.

3. Select Screen. 

4. Select Enable Clear Type.

Automatic Gain Control
Since the MVC 2050 requires a headset to operate properly, there may 
be a requirement to disable Automatic Gain Control to ensure optimum 
audio quality. 

Note: When the PDA is used in handsfree mode, without a headset, 
the PDA microphone picks up sounds from the speaker, creating a 
feedback loop. Automatic Gain Control is used in this instance to 
avoid feedback. For further information about device hardware 
settings, see your PDA�s Help system.

To disable Automatic Gain Control:

1. Select Start.

2. Select Settings.

3. Select System.

4. Select one of the following, depending on the PDA you are using:

a.  Audio

b.  Advanced Sounds

c.  Microphone 

5. Select Automatic Gain Control.
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6. Select Disable.

7. Select Yes.

For further information about MVC 2050 configuration and settings, see 
the MVC 2050 Help system.
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Mobile Voice Client 2050 Call 
Handling screen

Starting the MVC 2050

To start the MVC 2050 from your PDA:

1. From your PDA�s Main Application screen, select Start.

2. Select Programs. See Figure 6.

3. Select Mobile Voice Client 2050. The Call Handling screen appears. 
See Figure 7 on page 80.

Figure 6: Starting MVC 2050 from Main Application screen
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Figure 7:  Call Handling screen (with Toolbar retracted)

Navigation

You can use the up, down, left, and right cursor control arrow keys on 
your PDA as navigation buttons to move around the display of MVC 2050.

Appearance

The appearance of the Call Handling Screen differs with each available 
skin. For more information about skins, see �MVC 2050 graphical 
interface (skins) components� on page 81. 

The MVC 2050 uses a special screen font which requires that 
ClearType® be enabled on your PDA. ClearType software improves the 

Quit

Messages

   Directory

Volume Up

Mute

Paste
Contacts

Toolbar Toggle
Settings

Shift
Services

Expand
Copy

AAA1214_2.bmp

Volume Down

Menu Bar

Toolbar

Message
Lamp Display

Call Handling
icons

System Input

Dialpad



Mobile Voice Client 2050 Call Handling screen

81

appearance and readability of text on liquid crystal displays (LCDs), 
pocket PC screens, and flat panel monitors. See �MVC 2050 
configuration� on page 77 for information about enabling ClearType.

MVC 2050 graphical interface (skins) 
components

The MVC 2050 skins are the graphical representation of the MVC 2050. 
The diapad, menu, and icon buttons are located on the skin. Skins come 
in several colors and arrangements. 

To select a skin:

1. Select Settings.

2. Select Skin.

3. Select a skin from the list.

All skins share the following common components. See Figure 8 on 
page 82.

� programmable line/feature keys

� soft keys (self-labeled)

� dialpad

� display

� Call Handling icons

� Toolbar icons

� Menu Bar icons

� retractable toolbar

� System Input Panel icon

See the following examples of the MVC 2050 skins: Figures 8 to 11 
starting on page 82 and Figure 18 on page 93.
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Figure 8: Black skin

Figure 9: Blue skin
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Figure 10: Lime skin

Figure 11: Round skin
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Display
The display is located in the central area of the skin. See Figure 8 on 
page 82.

Programmable line/feature keys
Six programmable line/feature keys are located on the right side of the 
skin. They are aligned vertically and are the same color as the display. 
See Figure 8 on page 82. On the round skin, the programmable lIne/
feature keys are arranged in two rows of three on either side of the skin, 
under the dialpad. Figure 11.

Soft keys (self-labeled)
Four soft keys (self-labeled) are located in the bottom row of the display 
area. See Figure 8 on page 82.

Note 1: The label on the key changes, based on the active feature.

Note 2: A triangle before a key label indicates that the key is active.

Dialpad
The 12-button dialpad is located on the left-hand side of the skin. See 
Figure 8 on page 82. The dialpad is located in the center of the Round 
skin. See Figure 11 on page 83.

Message Lamp 
The Message Lamp lets you know if you have voicemail waiting. See 
Figure 8 on page 82. 

Mute Indication Lamp
The color of the Mute button changes to red when the call is muted. The 
Toolbar must be retracted to see this indicator because the Toolbar icon 
for Mute does not change color when the microphone is muted. See 
Figure 18 on page 93.
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Menus

The MVC 2050 provides the following menus:

� File

� Keys

� Help

File
The following items are available from the File menu:

� Run in background

� Paste

� Contacts

� Settings

� Exit

See Figure 12 on page 86.
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Figure 12: File menu

Run in background 
Select Run in Background to close the MVC 2050 and keep it running in 
the background so that incoming calls can ring on your PDA. 

To accept an incoming call while the MVC 2050 is running in the 
background:

1. From the Main Application screen, select Start.

2. Select Recently Used Application.

Note: You can also select Start > Today or Start > Home, 
depending on your PDA. When you select Start > Today or 
Start > Home, the MVC 2050 icon appears in the lower right corner 
of this screen.

After you have completed your call, press the �X� in the upper right-hand 
corner of the PDA display to close the application. See Figure 12. This 
returns the MVC 2050 to Run In Background mode.

AAA1212.bmp
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Paste
Select Paste to paste a telephone number, copied from another 
application, into the MVC 2050. You can do this to place a call rather than 
entering it through your Call Handling screen dialpad.

Contacts
Select Contacts to launch the Contacts dialog box. The Contacts 
application reads a list of contacts from the PDA Contacts list. The PDA 
Contacts List application can normally be synchronized with Outlook on 
your desktop PC.

Settings
The following items are available on the File > Settings submenu: 

� Profiles

� Server

� Skin

� Features

� Macros

� Audio

� About

� Language

� Hardware ID

� Advanced Audio

� Listener IP

� Sounds

For more information about Settings, see �Mobile Voice Client 2050 
settings� on page 127. 

Exit
Select Exit to close the MVC 2050. Once you select Exit, you cannot 
place or receive calls until you re-start the application. For more 
information, see �Run in background� on page 86.
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Note: Selecting Exit frees up PDA processing resources.

Keys
The following items are available from the Keys menu:

� Headset

� Answer

� Goodbye

� Hold

� Features

� Macros

Figure 13:  Keys menu

Headset
Select Headset to answer an incoming call or to obtain dial tone to place 
a call. (See also the Headset/Answer icon, located at the top, center, of 
the Call Handling screen).

AAA1213.bmpAAA1213.bmp
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Answer
Select Answer to answer an incoming call or to obtain dial tone to place a 
call. See also the Headset/Answer icon, top center in the Call Handling 
screen.

Goodbye
Select Goodbye to end your call. See also the Goodbye icon, top right in 
the screen.

Hold
Select the Hold menu item to place a call on hold. See also the Hold 
icon, top left in the Call Handling Screen.

Features
Select Features to access to a menu of interface keys. The defaults vary 
depending on which type of communication server you are connected to.

� See Figure 14 on page 90 to access the Features submenu from the 
Keys screen. 

� See Figure 15 on page 90 to access the Features menu from the 
Settings screen.

The following are the default Features:

� Message

� Shift

� Directory

� Services

� Expand

� Copy

� Quit

� Redial List

� Callers List

Items in Features submenu can be re-organized using the Settings > 
Features tab; however, items cannot be added or removed.
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Figure 14: Keys > Features screen

Figure 15:  Settings > Features screen  

Macros
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Select Macros from the Keys menu to access macros available through 
the Settings > Macros dialog box. You can use macros to make speed-
dial calls, access voicemail, and perform routine functions faster and 
easier (see �Macros� on page 137).

Help
The following items are available from the Help menu:

� Contents

� Diagnostics

� About MVC 2050

MVC 2050 offers a PDA-specific version of Help, shown in Figure 16.

Figure 16: Help menu 

Contents
Select Contents to access the MVC 2050 Help system.

AAA1214.bmpAAA1214.bmp
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Diagnostics
Diagnostics provides access to a list of methods to determine server 
connection state.

To access Diagnostics:

1. Select Help.

2. Select Diagnostics to see the following items in the drop-down list. 

� Ping

� Trace Route

� RUDP Ping

About MVC 2050
Select About MVC 2050 to see the MVC 2050 system product name, 
version number, copyright indication, Nortel Networks name and logo, 
and Global IP Sound® name and logo. The MVC 2050 uses packet loss 
concealment provided by Global IP Sound�s NetEQ� software. 

Figure 17:  About screen
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Figure 18:  Call Handling screen (with Toolbar retracted)

Icons

See Figures 18 and 19 to view the icons available in the MVC 2050.

Icons can be divided into three types:

� Call Handling icons

� Toolbar icons

� Menu Bar icons

Quit
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 Volume Up
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Figure 19:  Icons

Call Handling icons
The Call Handling icons are:

� Hold

� Answer/Headset

� Goodbye

These Call Handling icons are located at the top of the skin. See Figure 
19. The call handling icons are located across the middle of the Round 
skin.

Hold
Use the Hold icon to place calls on Hold and remove them from Hold.
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Answer/Headset
Use the Answer/Headset icon to receive and place calls. 

Goodbye
The Goodbye icon is used to terminate calls.

Toolbar icons
The Toolbar icons are: 

� Directory

� Messages

� Shift

� Services

� Expand

� Copy

� Quit

� Callers List

� Redial List

The Toolbar icons are visible when the Toolbar is retracted.

See Figures 18 and 19 to view the Toolbar retracted.

Note 1: Select Keys >  Features to view menu items that are exact 
equivalents to tapping these Toolbar icons. 

Note 2: Volume Up, Volume Down, and Mute (which are covered 
when the Toolbar is shown) are also repeated on the Toolbar. 

Directory
The Directory icon, depending on how your system administrator has set 
up this service, may access a local directory, the Personal Directory with 
up to 100 entries, Password Administration, or some other server-
based directory service.

Select the Directory icon to place a call. Directory accessibility depends 
on the system you are connected to.
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Inbox/Messages
Select the Inbox/Messages icon to access your messages or to return a 
call.

Outbox/Shift
Select the Outbox/Shift icon to shift between sets of programmable line/
feature keys. 

Services
Select the Services icon to access a list of network services. 

Expand
Select the Expand icon to access additional services, depending on the 
system you are connected to. 

Copy
Select Copy to add contacts to the Personal Directory by copying entries 
from the Redial List, the Callers List, or other directory applications. 
Availability of the Copy feature depends on which type of communication 
server you are connected to, and on how your system administrator has 
set up the Directory service.

Tip: If you are creating multiple entries in the Personal Directory, you can 
make and edit multiple copies in an existing entry. 

Quit
Select the Quit icon to exit a network service or feature.

Callers List
The Callers List icon provides access to information on up to 100 
telephone numbers of calls received.

Redial List
The Redial List icon provides access to information on up to 20 
telephone numbers you have recently dialed.
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Menu Bar icons
The Menu Bar icons are:

� Paste

� Contacts 

� Settings 

� Toolbar toggle

� System Input

Paste
Use the Paste icon to paste a number from another application to the 
MVC 2050.

Settings
Select the Settings icon to view the Settings screens. 

Contacts List
Use the MVC 2050 Contacts List icon to view, select, and dial contacts. 
The MVC 2050 Contacts List is a read-only list available from the PDA 
Contacts List. To add, modify, or delete entries, use the PDA Contacts 
application. The PDA Contacts List can also be updated by 
synchronizing it with your deskptop�s Outlook directory using Microsoft® 
ActiveSync®. See your PDA�s user guide for a description of this feature. 

Toolbar
Select the Toolbar icon to toggle the Toolbar display on and off. 

System Input
The System Input icon in the system tray at the bottom right-hand corner 
of the PDA provides access to the System Input Panel, shown in 
Figure 8 on page 82. Consult your PDA documentation for a description 
of the System Input Panel.

You can use the System Input Panel to enter data for the MVC 2050 and 
other applications. 
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The following are four methods you can use to input data on your PDA: 

� Keyboard

� Transcriber

� Letter Recognizer

� Block Recognizer

Using the MVC 2050 application, the PDA keyboard can act like a 
dialpad. For instance, the alphabetical J, K, or L is interpreted as a 
number five (5). Keys that are not alphanumeric are ignored. 

You can use a transcriber to write a telephone number on the display 
area to place a call. See Figure 20.

Figure 20:  Transcriber used to enter a number
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Menu and icon summaries

File menu
Table 6 summarizes the File menu selections. 

Table 6: File menu 

Selection Description

Run in Background Closes the MVC 2050 application, but leaves it 
running in the background to allow incoming 
calls to be received.

Paste Pastes a telephone number into the call 
interface to place a call (also available as a 
Menu Bar icon).

Contacts Opens the Contacts List (also available as a 
Menu Bar Icon).

Settings Provides access to the Settings dialog boxes 
(also available as a Menu Bar Icon).

Exit Shuts down the MVC 2050 application (also 
available as a Menu Bar Icon).
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Keys menu
Table 7 summarizes the Keys menu selections. 

Help menu
Table 8 summarizes the Help menu selections. 

Table 7: Keys menu

Selection Description

Headset Answers an incoming call or provides dial tone so you 
can make a call (also available as the Headset/
Answer icon located at the top center of the display).

Answer Answers an incoming call or provides dial tone so you 
can make a call (also available as the Headset/
Answer icon located at the top center of the display).

Goodbye Releases the call. 

Hold Places the current call on hold (also available as the 
Hold icon at the top left of the display).

Features Presents a menu of available features.

Macros Presents a menu of the programmed macros.

Table 8: Help menu

Selection Description

Contents Accesses the Help system.

Diagnostics Provides access to MVC 2050 diagnostics.

About Provides information about your MVC 2050 system.
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Managing Mobile Voice Client 
2050 calls

Making a telephone call 

Use the following procedure to make a call from your PDA using the 
MVC 2050: 

1. Plug the headset into the PDA and put it on.

2. Select Mobile Voice Client 2050 from the Start > Settings/System 
menu or Start > Programs menu.

3. Open the line by selecting one of the following:

� Headset/Answer icon

� Answer key from the Keys menu

� a line key

4. Dial the number by using one of the following: 

� dialpad

� macro

� Contacts within the MVC 2050 interface

� network Directory 

� Personal Directory

� Callers List

� Redial List

� Paste icon or menu item to paste a number copied from another 
application

� a PDA System Input Panel such as the keyboard, block 
recognizer, letter recognizer, or transcriber to write the number on 
the input screen
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Tip: To use the transcriber, select the System Input Panel icon, select 
transcriber from the drop-down list, and write the number in the 
application display area using your PDA�s transcriber.

Answering a call 

Use the following procedure to answer a call from your PDA:

1. Select one of the following:

� Headset/Answer icon 

� Answer key from the Keys menu

� ringing line key

2. Speak into your headset microphone.

Holding a call 

Select the Hold icon or select Hold from the Keys menu to place a call on 
hold.

Retrieving a call 

Select the line key to retrieve a call from Hold.

Ending a call 

Select the Goodbye icon or select Goodbye from the Keys menu to end 
your call. 
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Maintaining call quality

If you are experiencing poor quality during a call on the MVC 2050, move 
closer to the WLAN access point. Distance from the access point reduces 
the throughput/data rate. 

Using MVC 2050 on a PDA in a closed area or indoors also reduces the 
throughput, compared to open space. 

MVC 2050 does not support Bluetooth accessory use. Bluetooth and 
802.11b operate on the same frequency band and use the same WLAN 
hardware on the PDA.
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Managing Contacts with 
Mobile Voice Client 2050

You can place a call from your list of contacts in the PDA�s Contacts 
application using Mobile Voice Client (MVC) 2050. See Figure 21.

Use the Contacts application to do the following:

� add or modify entries on the PDA

� download entries from the Outlook contacts on your PC

� use the infrared ports on two PDAs to transfer entries between them 
(beam)

Figure 21:  Starting Contacts and the Contacts application 
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Editing the Contacts list

See the Contacts Help on your PDA for information about adding, 
deleting, and editing Contacts. 

See the appropriate Help screen for information on editing the Contacts 
in Outlook on your desktop PC.

Accessing Contacts Help

Use the following procedure to access your PDA�s Contacts Help system:

1. Select Start. A drop-down list appears.

2. Select Contacts. The Contacts screen appears.

3. Select the word Contacts at the top of the screen. The drop-down list 
appears.

4. Select Help. The Contacts Help screen appears.

Accessing the PDA Contacts list

Use the following procedure to access your PDA Contacts list:

1. Open the PDA�s Today or Home screen.

2. Select Start > Contacts. The Contacts read-only screen appears.

Note: To view the Contacts list within the MVC 2050, select 
File > Contacts. See Figure 22 on page 106.
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Figure 22:  MVC 2050 Contacts screen

Dialing a number from the Contacts list

Use the following procedure to dial a number from the MVC 2050 using 
the Contacts list:

1. Select File > Contacts. The Contacts list appears.

2. Double-tap the name or number you want to dial. The Phone details 
dialog box appears. See Figure 23 on page 108.

3. Use the Phone details dialog box to modify the number to be dialed, 
as needed.

4. To dial the number, press the check-mark in the lower left-hand 
corner of the display. See Figure 23 on page 108.

AAA1219.bmp
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Dialing formats

Numbers must be in the canonical dialing format in order for your PDA to 
use them for dialing. 

The canonical address format is a universal telephone number format 
recognized by the WIndows Telephony Application Interface (TAPI).

The canonical format identifies the components of a telephone number, 
which TAPI translates according to a country�s or region�s dialing rules. 
The canonical format is:

+ Country/Region Code (Area Code) Subscriber number

Note: For further information on canonical dialing, refer to the 
Microsoft web site.

When you select File > Contacts and double-tap a number to dial from 
the contacts list, the Phone details dialog box appears, shown in 
Figure 23 on page 108. The dialog box provides options for the criteria to 
properly route your call. 

Use the Phone details dialog box to:

� modify the number being dialed

� select or deselect canonical dialing rules

� interpret the number as a private network (ESN) number
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Figure 23: Phone details dialog box

The following are the components for creating and using canonical dialing 
numbers:

� area code, in the Contacts application

� dialing properties, called Dialing Locations (see Figure 24 on 
page 109)

Note: Information in the Dialing Locations tab indicates the origin of 
the call.

553-AAA1529
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Figure 24: Dialing locations
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You set the patterns for local, long-distance, and international dialing 
using Dialing Patterns. See Figure 25.

Figure 25: Dialing patterns

Area code
Set the Area code to provide the default area code for dialed numbers.

To establish the default Area code:

1. Select the PDA Contacts > Tools > Options.

2. Assign the correct value to the Country/Region and Area code.

See Figure 24 on page 109.
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The Contacts application prefixes the default area code to numbers you 
enter in your Contacts application. The PDA attempts to interpret the 
numbers as canonical. 

For example: enter a seven-digit number. Contacts assumes that the 
number is in your area code, and it adds the area code as a prefix to the 
seven-digit number to create a canonical number.

 In North America, if you enter a default area code of �415� in your 
Contacts and then enter the number �555-1212�, the following occurs:

� Contacts prefixes the area code to the number

� the displayed number changes to �(415) 555-1212�. 

This number is interpreted as a canonical number that the PDA can use 
for dialing.

Dialing Locations
Dialing Locations describe the dialing rules to be applied when you dial a 
number. The dialing rules allow you to enter prefixes to access local and 
long-distance numbers. Use the location of your server. See Figure 24 on 
page 109.

To establish the dialing rules:

� Select Start > Settings > Connections > Dialing Locations.

� Enter your server�s Area Code.

� Enter your server�s Country Code.

� Specify Tone dialing.

� Select Dialing Patterns.

� Enter or modify the dialing patterns for local calls, long-distance calls, 
and international calls.
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Example
An end user has a DN on a server located in Atlanta and another DN on a 
server located in New York. The end user has set up two dialing 
locations: one named �Atlanta��, with an area code of 404, and another 
named �New York�, with an area code of 646. The end user has also 
entered �646� as the default area code in the Contacts application. 

The end user has also programmed Dialing Patterns as follows:

� For local calls, dial: 9,G

� For long-distance calls, dial: 6,1FG

� For international calls, dial: 6,011,EFG

Note:  According to the Dialing Patterns dialog, E means insert 
country code, F means insert area code, and G means insert the 
number. Insertion of �,� (a comma) indicates a one half-second 
pause. 

� With the location of New York selected, the end user enters 
information for a contact whose business number is 555-1212. 
The Contacts application uses the Contacts Area code to 
determine that the area code should default to 646.

� With the location of New York selected, the end user enters 
information for a contact whose business number is 416-555-
1212. The end user enters all 10 digits to record the number in 
Contacts as (416) 555-1212.

� With the location of New York selected, when the end user 
selects 555-1212 in the MVC 2050 Contacts list and selects Dial 
Business, the Phone details dialog box appears and displays the 
number to be dialed as 9,5551212. 

� With the location of New York selected, when the end user 
selects 416-555-1212 in the MVC 2050 Contacts list and selects 
Dial Business, the Phone details dialog box appears and displays 
the number to be dialed as 6,4165551212.

� With the location of Atlanta selected, when the end user selects 
555-1212 in the MVC 2050 Contacts list and selects Dial 
Business, the Phone details dialog box appears and displays the 
number to be dialed as 9,16465551212.
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See your PDA Help system for a description for the values used in dialing 
patterns.

ESN numbers
To enter ESN numbers in Contacts, enter the ESN prefix followed by the 
number.

Note: PDA Contacts does not accept the �~� character used in the 
IP Softphone 2050 to express ESN numbers. You can provide a �~� 
character to your PDA Contacts application by storing a �~� character 
prefix digit in your PC Outlook Contacts. Then use ActiveSync to 
synchronize your PDA with your PC Outlook. This will transfer the �~� 
to your PDA. 

To assign the ESN prefix:

1. Dial a number using the Contacts list. 

2. When the Phone details dialog box appears, select ESN and enter 
or modify the ESN prefix in the box.

See Figure 26 on page 114.
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Figure 26: ESN dialing

Extension numbers
The PDA Contacts application normally dials extension numbers only if 
they do not satisfy Microsoft�s criteria for numbers that require an area 
code. 

The following three methods can be used to manage dialing extension 
numbers:

1. Select Extension in the Phone details dialog box. See Figure 27 on 
page 115. 

2. Enter extension numbers in your PC�s Outlook Contacts application 
and ActiveSync your PC�s Outlook with your PDA�s Contacts.

Select Keys > Macros and enter the direct dial extension number in a 
macro. See �Macros� on page 137 for information about macros.

553-AAA1532
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Figure 27: Extension Number
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Personal Directory, Redial List, 
and Callers List

Personal Directory, Redial List, and Callers List are features supported on 
CS 1000 systems running CS 1000 Release 4.0 software. The contents 
of these directories are maintained in a remote, central database called 
the Application Server. 

To open Personal Directory, Redial List, or Callers List:

1. Tap the Directory icon.

2. Make your selection from the following list.

� Personal Directory

� Callers List 

� Redial List 

� Password Administration 

Note: The Personal Directory, Redial List, and Callers List features 
have a one-minute time-out control period. If the application is idle for 
one minute during any of the operations, the application is closed and 
your IP Softphone 2050 goes back to the idle state.

The Personal Directory, Redial List, and Callers List features support:

� multiple languages

� access using the Directory key

� feature launch while in Call Transfer and Conference modes (your 
MVC 2050 does not have to be idle)

� Branch Office in normal mode only

� Virtual Office

� menu-driven configuration of Station Control Password (SCPW) from 
your IP Softphone

� database backup and restoration by your system administrator

� system administrator functions, such as unlocking your SCPW
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� system administrator restoration of profiles for single, multiple, or all 
users

User preferences for Personal Directory, Redial List, 
and Callers List
The following is a list of options you can change:

� language

� date/time display format

� call timer

� name display format

� call log options

� log all/unanswered calls

� area code setup

� preferred name match

� new call indication

To set user preferences:

1. Tap the Services icon.

2. Tap Telephone Options.

3. Select one of the following:

� Language

� Date/time

4. Scroll down the list.

5. Tap your selection.

6. Tap Select or Cancel.

Call Log Options
The following is a list of Call Log Options:

� Log all/unanswered incoming calls

� New call indication
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� Preferred name match

� Area code set-up

� Name display format

Table 9 describes the Call Log Options.  

Table 9: Call Log Options (Part 1 of 2)

Call Log Option Description Default value

Log all/unanswered 
incoming calls

Callers List logs all of 
the incoming calls or 
only the unanswered 
incoming calls. 

Log all calls

New call indication Telephone displays a 
message indicating that 
a new incoming call 
was received.

On

Preferred name 
match

If set to Off, the CPND 
from the Call Server is 
displayed for an 
incoming call. If set to 
On, the name stored in 
the Personal Directory 
is displayed, if a match 
is found.

Off

Area code set-up Incoming call phone 
numbers display in the 
order you set, if the 
area code matches one 
of the three that you 
have set up. Example: 
area code first or area 
code last.

No area code 
specified
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To set Call Log Options:

1. Tap the Services button.

2. Tap Telephone Options.

3. Tap Call Log Options.

4. Tap one of the following:

� Incoming Calls

� Preferred Name Match

� Area Code Setup

� Name display format

5. Scroll through the selected list.

6. Tap your selection.

7. Tap Select or Cancel.

Personal Directory
You control your own Personal Directory. You can create up to 100 
entries. You can edit, copy, or delete individual entries, or delete the 
entire list, and you can copy entries from other applications to Personal 
Directory or from Personal Directory to other applications.

The following list describes the contents of a Personal Directory entry:

� last name (up to 24 characters)

� first name (up to 24 characters

� DN at work (up to 31 characters)

Name display format You can define the 
format of the name 
displayed for incoming 
calls. The options are: 
first name/last name or 
last name/first name

First name/last 
name

Table 9: Call Log Options (Part 2 of 2)

Call Log Option Description Default value
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� DN at home (up to 31 characters

� cell phone (up to 31 characters)

� pager (up to 31 characters)

To add a contact to Personal Directory:

1. Tap the Directory icon.

2. Tap Personal Directory.

3. Tap the Add key to start a text editor.

4. Enter the contact information. 

TIP: you can tap the Pause soft key any time during data entry to add 
a pause in the number.

5. Tap Done to submit the entry. 

You can also add contacts to the Personal Directory by copying entries 
from the Corporate Directory, the Redial List, the Callers List, or other 
available directory applications. If you are creating multiple entries in the 
Personal Directory, you can make and edit multiple copies of an existing 
entry.

To edit a contact in the Personal Directory:

1. Tap the Directory icon.

2. Select Personal Directory from the Directory list.

3. Search for the desired entry.

4. Highlight the entry.

5. Tap the Edit soft key and make the changes.

6. Tap the Done soft key.

You can temporarily edit contacts in the Redial List and the Callers List 
then dial the edited entry. The changes are not retained.

To dial from the Personal Directory:

1. Tap the Directory icon.

2. Scroll to the Personal Directory.
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3. Tap Personal Directory.

4. Find the contact by one of the following:

� Scroll to the desired contact.

� Search for the contact by name or number.

� Enter the number of the contact to find it.

5. Double-tap the contact to dial the selected entry.

Call Log features: Redial List and Callers List
Redial List and Callers List are Call Log features. The content of Redial 
List and Callers List is generated by the system during call processing. 
You can delete individual entries or the entire directory in Redial List and 
Callers List, but you cannot add an entry or permanently change the 
content of an entry.

Callers List
The Callers List can contain up to 100 entries. When the list is full, the 
system overwrites the oldest entry. 

In Directory View mode, the caller�s name displays along with the Callers 
List entry count. Entries in the Callers List are sorted by Call Log time. 
The first entry you see is the first new entry. If you press the down 
navigation key, more new items in the Callers List display. If you press the 
up navigation key, an older item in the list displays. 

The following list describes the contents of a Callers List entry:

� last name (24 characters)

� first name (24 characters)

� DN (31 characters)

� time/date

� number of calls
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Dialing from the Callers List
To dial from the Callers List:

1. Do one of the following to open Callers List:

� Tap the Callers List icon on the Toolbar

� Tap the Directory icon and tap Callers List.

2. Find the contact by one doing of the following:

� Scroll to the desired contact

� Search for the contact by name or number

� Enter the number of the contact to find it 

3. Double-click the contact to dial the selected entry.

Redial List
The Redial List can contain up to 20 entries. When the list is full, the 
system overwrites the oldest entry.

In Directory View mode, the number you dialed is displayed. Redial List 
content is updated when you dial out. Entries in the Redial List are sorted 
by Call Log time. The oldest entry is at the beginning of the list. Press the 
down navigation key to go to the newest entry and press the up 
navigation key to go to the oldest.

The following list describes the contents of a Redial List entry:

� user name (up to 24 characters)

� DN (up to 31 characters)

� time of the last call occurrence

� time/date

Dialing from the Redial List
To dial from the Redial List:

1. Do one of the following to open Redial List:

� Tap Redial List on the Toolbar.

� Tap the Directory icon and tap Redial List.



Personal Directory, Redial List, and Callers List

123

2. Find the contact by one doing of the following:

� Scroll to the desired contact.

� Search for the contact by name or number.

� Enter the number of the contact to find it.

3. Double-tap the contact to dial the selected entry.

To temporarily edit a contact and dial it using the Redial List or the 
Callers List:

1. Tap the Directory icon.

2. Select Redial List or Callers List from the Directory list.

3. Search for the desired entry.

4. Highlight the entry.

5. Tap the Edit soft key and make the changes.

6. Tap the Dial soft key to dial the edited entry.

To find contacts in Personal Directory, Redial List, or Callers List:

1. Tap the Directory icon.

2. Tap the desired directory and do one of the following:

� Scroll through the directory to the desired entry. 

� Enter the number of the entry to go directly to it.

� Search by first name, last name, or number.

To delete a contact in Personal Directory, Redial List, or Callers List:

1. Tap the Directory icon.

2. Select the Personal Directory, Redial List, or Callers List.

3. Search for the entry.

4. Highlight the entry.

5. Tap the Delete soft key.

6. Tap the Confirm or Cancel key.
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To delete the Redial List or Callers List:

1. Tap the Directory button.

2. Select Redial List or Callers List.

3. Tap the Del soft key.

4. Tap Yes.

Password Administration
The Password Administration feature is available on the Directory list. 
The Station Control Password (SCPW) protects your private directory 
information. You can perform Password Administration from your 
MVC 2050 once your SCPW is defined by your system administrator on 
the Call Server. This includes turning password protection on or off and 
changing your password.

When password protection is enabled, authentication is required before 
you can access Personal Directory, Redial List, or Callers List. You are 
prompted to enter your password in order to gain access to any of the 
password-protected features, such as Personal Directory, Redial List, 
Callers List, or Virtual Office.

Note: The default setting for Password Protection is Off.

To turn Password Protection On/Off:

1. Tap the Directory icon.

2. Select Change Protection mode.

If Password Protection is enabled, you are prompted to enter your 
password.

3. Tap one of the following:

� Ent to confirm

� Del to delete your password

� Clr to clear your password

� Can to cancel and return to the Directory list
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4. If you tapped Ent, select one of the following:

� Enable Pwd Protection

� Disable Pwd Protection

5. Tap one of the following:

� Yes to accept your selection

� No to return to the Directory list

6. If you selected Yes, tap Done to enable or disable Password 
Protection.

To change your password:

1. Tap the Services icon.

2. Select Telephone Options (you will be prompted to enter your 
password).

3. Enter your password.

4. Select New Password.

5. Tap one of the following:

� Sel to select New Password

� Del to return to the previous menu

� Clr to clear your password

� Can to end

If you tapped Sel, you are prompted to enter a new password.

6. Enter your new password and tap Sel. You are prompted to confirm 
your new password.

7. Tap one of the following:

� Sel to select New Password

� Del to return to the previous menu

� Clr to clear your password

� Can to end

If you tapped Sel, your password is changed.
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If you make three consecutive incorrect password attempts within an 
hour, you are locked out of the password-protected features for an hour. 
�Locked access� displays on your telephone. 

If Virtual Office is enabled, it is also locked out. If you fail to access Virtual 
Office with incorrect password attempts, your access to other password-
protected features is also locked out.

Your system administrator can reset and unlock your access at any time if 
you have been locked out or have forgotten your password.
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Mobile Voice Client 2050 settings

Use the MVC 2050 Settings to select choices for the appearance, 
behavior, and operation of your PDA. The Settings tab provides access 
to the following selections:

� Profiles

� Server

� Skin

� Features

� Macros

� Audio

� About

� Language

� Hardware ID

� Advanced Audio

� Listener IP

� Sounds

This section provides information about setting sounds to accompany 
events, profiles creation and use, server assignment, and macro creation 
and use. 

Sounds

The Mobile Voice Client (MVC) 2050 can make sounds to indicate server 
connection or disconnection.

Sound files and sound settings are not saved or transmitted between 
device infrared ports (beamed) when profiles are saved or beamed. 
Therefore, the sounds must be programmed by the user. 
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Audible notification of server connection or 
disconnection
You can program sounds to accompany notification of server connection 
or disconnection events.

To program up to three sounds for use with audible notification of server 
connection or disconnection:

1. Select File.

2. Select Settings.

3. Select Sounds.

Figure 28: Sounds - server connected 

Sounds are used for the following events:

� Server unreachable

� Server unresponsive

� Server connected

See Figure 29.

Sounds-ServerConnected.bmp
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Server unreachable
The sound you select for this event plays when MVC 2050 loses contact 
with the server. The message �Server unreachable� displays on the PDA 
screen.

Server unresponsive
The sound you select for this event plays if MVC 2050 fails to connect to 
the server. The message �Server unresponsive� displays on the PDA 
screen. 

Server connected
The sound you select for this event plays when MVC 2050 connects to a 
server. The message �Server connected� displays on the PDA screen.

Figure 29: Events list
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Profiles

Each profile is a named file that contains a combination of servers and 
other attributes that control the connection, behavior, and appearance of 
the MVC 2050. 

A number of profiles can be created and saved to allow easy switching 
among different servers, feature programming, and audio programming. 

Profiles can be created, selected, or deleted. Once selected, the name of 
the profile can be modified. 

When a profile is selected, all other Settings tabs refer to the selected 
profile. 

The name of the selected profile is shown in the lower-right corner on 
each tab. SeeFigure 30.

Figure 30: Profiles screen

AAA1189.bmp
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The profiles screen allows you to:

� create profiles

� delete profiles

� modify a profile�s name

� change the profile used by the application

� export profiles

� import profiles

Creating a new profile
Use the following procedure to create a new profile:

1. Select New. A screen appears with an empty text box labeled Name.

2. Enter the new profile name.

3. Select OK.

The Profiles screen re-appears. The new profile has been created and 
selected. The values on all the other tabs have been set to their defaults 
for this profile. Any value modified on any of the other tabs is associated 
with this profile until another profile is selected. To change settings on 
other tabs for this profile, select the tab you wish to change. For example, 
select the Server tab from the Settings screen to modify the default 
server settings. See Figure 31 on page 132.
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Figure 31: Selecting a profile  

Removing a profile
Use the following procedure to remove a profile:

1. From the drop-down list on the profiles tab, select the profile you want 
to remove. See Figure 31.

Note: �My Server� is a built-in profile name that cannot be deleted.

2. Select Remove.

The profile disappears from the list.

Modifying the name of a profile
Use the following procedure to modify the name of a profile:

1. Select the profile you want to change from the drop-down list on the 
profiles tab. See Figure 31.

2. Select Modify. The profile name appears highlighted.

3. Enter the new profile name.

4. Select OK.

   AAA1190.bmp
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The Profiles screen re-appears. The new profile is selected.

Changing the current profile
Use the following procedure to select the profile for your MVC 2050:

1. Select the name of the profile you want to change from the drop-down 
list at the top of the Profiles screen.

2. Choose one of the following:

a. If MVC 2050 is running, press Reset. The application 
disconnects from the current server and attempts to connect to 
the server defined by the newly selected profile. 

b. If MVC 2050 is not running, press OK. The next time the 
application starts, it uses the selected profile.

Note 1: To modify the profile itself, select the profile and select the 
tabs you wish to change.

Note 2: The application briefly indicates which profile is in use as it 
starts up. 

Exporting profiles
Use the following procedure to export a profile to a file:

1. Select Export. A dialog box appears. 

2. To save as a file, select �Export to a file�.

3. Select OK.

4. Enter a file name.

5. Use the folder object to select a directory. 

6. Select OK.

Note: To keep the profile as a backup, copy the profile to your 
desktop PC using ActiveSync.

Use the following procedure to export a profile to another device:

1. Select Export. A dialog box appears. 

2. To export to another device, select �Export to another device�.
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3. Select OK.

4. Align the infrared ports of the two devices. The profile is exported to 
the other device.

Importing profiles
Use the following procedure to import a profile from a file:

1. Select Import. A dialog box appears. 

2. To Import from a file, select �Import from a file�.

3. Select OK.

4. Use the file explorer to locate the file containing the profile. 

5. Select Cancel or Select.

6. Select OK.

7. Select the profiles to import. 

8. Select Cancel or Select.

9. Select OK.

Use the following procedure to import (beam) a profile from another 
device:

1. Select Import. A dialog box appears. 

2. To Import from another device, select �Import from another device�.

3. Select OK.

4. Align the infrared ports of the two devices.

5. Select the profiles to be imported.

Server

The Server tab contains all of the settings that enable MVC 2050 to 
contact a communication server. See Figure 32 on page 135.

Your system administrator sets up your LAN server to direct your 
MVC 2050 to the communication server. See Figure 34 on page 136.
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Figure 32: Server screen  

When you want to connect to your home office communication server 
rather than the local office server, if you are not using a Dynamic Host 
Configuration Protocol (DHCP) server, you can create a profile to manage 
the connection. 

This profile contains the IP address of the server you want to connect to 
and the server�s port number and type. See Figure 34 on page 136. For 
more information about creating and selecting a profile, see �Profiles� on 
page 130.

If your system is set up with DHCP, the primary and secondary server 
addresses are both assigned by way of DHCP and no action is required. 
See Figure 33 on page 136.

AAA1191.bmp
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Figure 33:  DHCP Setting on the Server screen

Figure 34:  Assigning Server values

AAA1192.bmp

AAA1193.bmp
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Macros

The Mobile Voice Client (MVC) 2050 Macros tab enables you to record 
and use macros. A macro is a recorded sequence of steps that saves you 
keystrokes. 

For example, you can create a macro that selects a particular line and 
then dials that telephone number automatically. Another example of 
macro use is programming voicemail access numbers and codes for 
faster access.

See Figure 35 and Figure 36 on page 138.

Figure 35: Keys > Macros menu

AAA1203.bmp



Mobile Voice Client 2050 settings

138

Macro screen

To enter a new macro name, or to select an existing macro to modify or 
delete, select the New icon to the right of the list box. See Figure 36.

To select an existing macro, tap the down arrow in the Macro list box and 
make your selection. 

To delete a selected macro, tap the Delete icon, the button to the right of 
the list box.

Figure 36: Macro screen

Delete

Dialpad 

New

AAA1204.bmp
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Keys
Once you have selected a macro name, tap the down arrow in the Keys 
drop-down list to select a key to add to the macro. Press the Add button 
to add the key. 

The Pause key is used to insert a short pause in the macro. A pause 
introduces a delay which may be required to access some Interactive 
Voice Response (IVR) applications and the voicemail systems.

Contents
A list of the macro�s contents appears in the Contents list box. Once two 
or more entries are in this box, the keystrokes can be moved around by 
using the up and down navigation buttons which appear to the right of the 
box.

You can remove keystrokes from the Contents box by selecting a 
keystroke and pressing the Remove button.

Preview
You can preview your macro in a single view by viewing the read-only 
field under the Contents box. 

Dialpad
You can select the Keys list box and press the Add button, or you can 
use the numbers on the dialpad to enter numbers into your macro.
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Mobile Voice Client 2050 for 
expert users

This section discusses the selections used to diagnose or correct error 
conditions and are not used during normal operation of 
Mobile Voice Client 2050.

Client diagnostics

Client diagnostics are used to determine the connection status of the 
MVC 2050. Access client diagnostics from the Help > Diagnostics 
screen. See Figure 16 on page 91. 

Diagnostics include: 

� Ping

� TraceRoute

� RUDP Ping 

Ping tests whether the network destination in on line.

TraceRoute is an operation for sending trace packets to trace the route of 
user datagram protocol (UDP) from local host to remote host.

RUDP Ping tests if the IP port is responding as a terminal proxy server 
(TPS).

See also �Profiles� on page 130 for information on changing, importing, 
and exporting profiles to assist in troubleshooting.
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Audio quality

Audio quality of voice transmission depends on many factors, such as 
codec characteristics, echo canceller, jitter buffer size, and listener 
perception. 

Audio quality is controlled from two screens: 

� Audio, the quality slider tab

� Advanced Audio (for expert users)

Audio quality slider
You can control audio quality using the slider tab to reduce audio delay 
and increase audio clarity. See Figure 37. The slider controls the number 
of audio buffers the PDA uses to smooth out incoming audio streams.

Figure 37: Audio quality screen

Audio delay
If you experience audio delay, you can decrease the number of buffers 
and reduce the delay by adjusting the slider on the Audio screen. 

AAA1205.bmp
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Audio clarity
If you experience breakups in the receive audio stream, adjust the setting 
towards Higher Quality. This increases the number of audio buffers used 
to process incoming audio. If the delay is too large, you can decrease this 
setting.

If you experience broken or choppy speech at either end of the call, or if 
the dial tone sounds choppy, your PDA�s volume control may be the 
cause. To prevent this problem, use the volume controls on the MVC 
2050 toolbar to adjust volume while using the MVC 2050.

Note: QoS 802.11 p/q is not supported due to device constraints. 

Advanced Audio
Advanced audio settings are recommended for use only by advanced 
users. See Figure 38 on page 143. 

NetEQ software, included with the MVC 2050 software, provides loss 
concealment and compensation and NetEQ is the default setting. 

You cannot adjust the MVC 2050 Advanced Audio settings. 
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Figure 38: Advanced Audio screen

AAA1208.bmp
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Items on the Advanced Audio screen 
Table 10 describes the selections available on the Advanced Audio 
screen. 

Table 10: Advanced Audio screen

Selection Description

NetEQ (Global IP Sound) NetEQ packet loss concealment 
software is the default mode of 
operation. 

Jitter Buffer The rate of arrival of voice frames is 
variable. A jitter buffer is used to 
minimize this variability by sending voice 
frames to your PDA sound system at a 
fixed rate. The value of �jitter� is the 
normal number of voice frames the 
application should have in its jitter buffer. 

Highwater Mark Highwater mark indicates the maximum 
number of voice frames the application 
should have in its jitter buffer before it 
starts discarding packets. This value 
should be at least 2.5 times the value of 
jitter. 

Early Packet and Late 
Packet Resync

Early Packet Resync and Late Packet 
Resync indicate the points at which MVC 
2050 discards and restarts the jitter 
buffer contents. This value should be at 
least 5 times the high water mark. 
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Listener IP

See Figure 39. This screen is for expert users only. It can be used to 
override the port assignments when a conflicting application is on the 
PDA.

Figure 39: Listener IP screen

AAA1209a.bmp AAA1209b.bmp
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Items on the Listener IP screen
Table 11 describes selections available on the Listener IP screen.

Hardware ID

See Figure 40 on page 147. This screen is for expert users and system 
administrators. It can be used to select the Media Access Control (MAC) 
address that the MVC 2050 reports to the communication server.

The Hardware ID being used by MVC 2050 can be viewed on the 
MVC 2050 Settings > Hardware ID tab.

The Hardware ID is generated by reading MAC addresses from the PDA's 
NIC. When the MVC 2050 is used with most server types, the Hardware 
ID it uses must be unique. Some software, such as VPN client software, 
creates artificial network interfaces with MAC addresses which are not 
unique. These may be addresses that are common to all installations of a 
particular VPN client. 

Table 11: Listener IP screen

Selection Description

Use a specific 
address

The MVC 2050 normally listens to all IP 
addresses on the device for communication 
server-to-terminal (UNIStim) messaging on all the 
Network Interface Cards (NIC) on the device. This 
is the default mode of operation. To override this 
behavior, select the check box and enter a 
specific IP address.

Use a specific 
port

The MVC 2050 listens to IP port 5000 on the 
device for communication server-to-terminal 
(UNIStim) messaging.
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Without a unique MAC address, users may not be able to connect to a 
server, or may connect to a server and cause another device with the 
same Hardware ID to be disconnected from the server. If the MVC 2050 
is disconnected from the server, it automatically attempts to reconnect, 
and the resulting conflicts will prevent a stable connection from being 
made.

Select the Auto-Create button on the Settings > Hardware ID screen to 
prevent conflict with another device. Auto-Create fabricates a random 
value, which is unlikely to be repeated by another device.

Figure 40: Hardware ID screen

AAA1207.bmp
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Table 12 describes items on the Hardware ID screen. 

Connection history

Connection history writes indication messages to the registry key 
�\HKCU\Software\Nortel Networks\MVC2050\Log� for connection or 
disconnection events. This is a circular queue of 29 entries. 

Each time a connection or disconnection event occurs, a log entry is 
written. The entries contain a date and time and a description of the 
connection or disconnection event. 

The following sections describe connection and disconnection events.

Table 12: Hardware ID screen

Selection Description

Hardware ID This box contains the MAC address for the Ethernet 
hardware installed in your device. MVC 2050 uses the 
MAC address of the Ethernet hardware as its 
Hardware ID. You may have to change this value if 
there is more than one MAC address, or if the device 
is using an Extranet client that hides the true MAC 
address. For example, the Nortel Networks Contivity 
Extranet Switch uses a single MAC address for all 
clients. This might cause connection problems with 
your communication server.

Auto-Create This changes the MAC address that appears in the 
Hardware ID box. If your device has more than one 
MAC address, press the Auto-Create button to cycle 
through the set of MAC addresses on your computer. 
Auto-Create also makes up random Hardware IDs in 
case the Ethernet hardware addresses are not unique 
to the communication server.

Firmware 
Version

Shows the build number of MVC 2050 installed on 
your device. This value is the version number of the 
application last reported by the server.
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Soft reset, server n
This message indicates that the server has instructed the MVC 2050 to 
reset and connect to a server n, where the value of n is determined, and 
possibly written, by the server. This maps directly to a UNIStim message.

Server connected
This message indicates that the MVC 2050 has successfully connected to 
the server. It means that the MVC 2050 received the �AssignTerminalID� 
UNIStim message, which is the last message received by the MVC 2050 
before a normal session commences.

Recovering: Server unreachable
This message is generated when the MVC 2050 has lost its connection 
with the server. It indicates that the UNIStim �watchdog timer� has 
expired. This indicates loss of network connection.

Hard Reset
This message indicates that the server has instructed the MVC 2050 to 
reset and clear its UNIStim-related memory. This maps directly to a 
UNIStim message.

WiFi

You can ActiveSync your PDA with your PC using WiFi.

WiFi use for a cradled PDA
If you do not want to lose the MVC 2050 connection to the server when 
you return the PDA to its cradle, deactivate ActiveSync. Otherwise, the 
connection is lost because ActiveSync uses Point-to-Point Protocol 
(PPP). This causes the PDA connection to the network to be dropped and 
then connected to the PC.

Application Server Administration
This feature is available for your system administrator. The Personal 
Directory, Redial List, and Callers List features use a separate, central 
database, called the Application Server, to store directory data and user 
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profile options. Backup and restoration of the database can be performed, 
and user profiles can be managed, by your system administrator using 
the Application Server Administration feature. 
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